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Notice

The company reserves the right to revise this publication or to change its contents without notice. Infor-
mation contained herein is for reference only and does not constitute a commitment on the part of the man-
ufacturer or any subsequent vendor. They assume no responsibility or liability for any errors or
inaccuracies that may appear in this publication nor are they in anyway responsible for any loss or damage
resulting from the use (or misuse) of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated,
transmitted or reduced to any machine readable form without prior consent from the vendor, manufacturer
or creators of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered
trademarks of their respective companies. They are mentioned for identification purposes only and are not
intended as an endorsement of that product or its manufacturer.

©August 2004

Trademarks

This product incorporates copyright protection technology that is protected by method claims of certain
U.S. patents and other intellectual property rights owned by Macrovision Corporation and other rights
owners. Use of this copyright protection technology must be authorized by Macrovision Corporation, and
is intended for home or other limited viewing uses only unless otherwise authorized by Macrovision Cor-
poration. Reverse engineering or disassembly is prohibited.

Intel and Pentium are registered trademarks of Intel Corporation.
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FCC Statement

(Federal Communications Commission)

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television reception, which can
be determined by turning the equipment off and on, the user is encouraged to try to correct the interference
by one or more of the following measures:

» Reorient or relocate the receiving antenna.

 Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
« Consult the service representative or an experienced radio/TV technician for help.

2N
Z &
Warning

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifica-
tions not expressly approved by the manufacturer for compliance with the above standards could void your au-

thority to operate the equipment.
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IMPORTANT SAFETY INSTRUCTIONS

When using your telephone equipment, basic safety precautions should always be followed to reduce the
risk of fire, electric shock and injury to persons, including the following:

1.

2.

Do not use this product near water, for example near a bathtub, washbowl, kitchen sink or laundry tub, in
a wet basement or near a swimming pool.

Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm.
There may be a remote risk of electrical shock from lightning.

Do not use the telephone to report a gas leak in the vicinity of the leak.

Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They
may explode. Check with local codes for possible special disposal instructions.

This product is intended to be supplied by a Listed Power Unit (DC Output 20V, 3.25A minimum).

CAUTION

Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equip-
ment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER,

TELECOMMUNICATION LINE CORD
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Instructions for Care and Operation
The computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. Don’'tdrop it, or expose it to shock. If the computer falls, the case and the components could be

damaged.

Do not expose the computer
to any shock or vibration.

Do not place it on an unstable
surface.

Do not place anything heavy
on the computer.

2. Keep itdry, and don’t overheat it. Keep the computer and power supply away from any kind of
heating element. This is an electrical appliance. If water or any other liquid gets into it, the computer
could be badly damaged.

Do not expose it to excessive
heat or direct sunlight.

@

Do not leave it in a place
where foreign matter or mois-
ture may affect the system.

Don't use or store the com-
puter in a humid environment.

Do not place the computer on
any surface that will block the
vents.
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3. Avoid interference. Keep the computer away from high capacity transformers, electric motors, and
other strong magnetic fields. These can hinder proper performance and damage your data.

4. Follow the proper working procedures for the computer. Shut the computer down properly and
don’t forget to save your work. Remember to periodically save your data as data may be lost if the

battery is depleted.

Do not turn off the power
until you properly shut down
all programs.

Do not turn off any peripheral
devices when the computer is

on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance
on your computer.

5. Take care when using peripheral devices.

Use only approved brands of
peripherals.

Unplug the power cord before
attaching peripheral devices.




Preface

Power Safety
The computer has specific power requirements:

N  Only use a power adapter approved for use with this computer.

7£l§ * Your AC adapter may be designed for international travel but it still requires a
Power Safety steady, uninterrupted power supply. If you are unsure of your local power specifi-

Warning cations, consult your service representative or local power company.

Before you undertake » The power adapter may have either a 2-prong or a 3-prong grounded plug. The

any upgrade proce- third prong is an important safety feature; do not defeat its purpose. If you do not

dures, make sure that have access to a compatible outlet, have a qualified electrician install one.

you have turned off the » When you want to unplug the power cord, be sure to disconnect it by the plug head,

power, and _dlscon- not by its wire.

LB EEIEIEE S . Make sure the socket and any extension cord(s) you use can support the total cur-

and cables (including .

telephone lines). It is rent load of all the connected devices.

advisable to also re- « Before cleaning the computer, make sure it is disconnected from any external

move your battery in power supplies (i.e. AC adapter or car adapter).

order to prevent acci-

dentally turning the

machine on.

Do not plug in the power Do not use the power cord if | Do not place heavy objects
cord if you are wet. it is broken. on the power cord.
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Battery Precautions

* Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the com-
puter.

» Recharge the batteries using the computer’s system. Incorrect recharging may make the battery explode.

» Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative
or qualified service personnel.

» Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully.
Batteries may explode or leak if exposed to fire, or improperly handled or discarded.

» Keep the battery away from metal appliances.

» Affix tape to the battery contacts before disposing of the battery.

» Do not touch the battery contacts with your hands or metal objects.

>N\
Z &
Battery Disposal

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of
its useful life, under various state and local laws, it may be illegal to dispose of this battery into the municipal
waste stream. Check with your local solid waste officials for details in your area for recycling options or proper
disposal.

Caution

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommend-
ed by the manufacturer. Discard used battery according to the manufacturer’s instructions.

Vi
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Touch Panel Care

e Touch Panels are made of glass, so do not subject them to heavy shock or stress.

» Do not place heavy objects on the Touch Panel.

» Please use a dry soft cloth when cleaning (do not use any organic solvent acid or alkali solution).

Cleaning

Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing

Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and
the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer
from the power supply. Then refer servicing to qualified service personnel under any of the following con-
ditions:

«  When the power cord or AC/DC adapter is damaged or frayed.

 If the computer has been exposed to rain or other liquids.

 If the computer does not work normally when you follow the operating instructions.

* If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
 If there is an unusual odor, heat or smoke coming from your computer.

VI
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Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

Check that the battery pack and any spares are fully charged.

Power off the computer and peripherals.

Close the display panel and make sure it's latched.

Disconnect the AC adapter and cables. Stow them in the carrying bag.

The AC adapter uses voltages from 100 to 240 volts so you won't need a second voltage adapter.
However, check with your travel agent to see if you need any socket adapters.

Put the computer in its carrying bag and secure it with the bag’s straps.

If you're taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those
devices’ adapters and/or cables.

8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership
for both hardware and software. Make sure your “papers” are handy.

akrwnE

No

>"N\Z
Z &
Power Off Before Traveling

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container).
Putting a notebook which is powered on in a travel bag may cause the vents/intakes to be blocked. To prevent

your computer from overheating make sure nothing blocks the vent/fan intake while the computer is in use.
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On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshoot-
ing, keep these points in mind:

Hand-carry the computer - For security, don’t let it out of your sight. In some areas, computer theft is
very common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful.
Avoid knocking the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the
computer, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your
computer and disks around the devices. Ask security officials to hand-inspect them (you may be asked to
turn it on). Note: Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in
flight. These restrictions are for your safety, follow them. If you stow the computer in an overhead com-
partment, make sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC adapter and keep your bat-
tery(ies) charged.

Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the
computer. Wait a few minutes before turning it on so that any moisture can evaporate.
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Developing Good Work Habits

Developing good work habits is important if you need to work in front of the computer for long periods
of time. Improper work habits can result in discomfort or serious injury from repetitive strain to your
hands, wrists or other joints. The following are some tips to reduce the strain:

» Adjust the height of the chair and/or desk so that the keyboard is at or slightly
below the level of your elbow. Keep your forearms, wrists, and hands in a relaxed
position.

* Your knees should be slightly higher than your hips. Place your feet flat on the
floor or on a footrest if necessary.

» Use a chair with a back and adjust it to support your lower back comfortably.

 Sit straight so that your knees, hips and elbows form approximately 90-degree
angles when you are working.

» Take periodic breaks if you are using the computer for long periods of time.

Remember to:

» Alter your posture frequently.

» Stretch and exercise your body several times a day.

» Take periodic breaks when you work at the computer for long periods of time. Fre-
quent and short breaks are better than fewer and longer breaks.

Xl
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Lighting
Proper lighting and comfortable display viewing angle can reduce eyestrain and muscle fatigue in your
neck and shoulders.

« Position the display to avoid glare or reflections from overhead lighting or outside sources of light.

» Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen
clearly.

« Position the display directly in front of you at a comfortable viewing distance.

» Adjust the display-viewing angle to find the best position.

Xl
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Chapter 1: Introduction

Overview

This manual refers to the hardware and essential software required to run your
computer. Depending on how your system is configured, some or all of the
features described may already be set up. This chapter covers:

. The Manual —  how to use it
. System Map —  navigating around your computer

Advanced Users

If you are an advanced user you may skip over most of this manual. However
you may find it useful to refer to “What to Install” on page 4 - 2, “BIOS Util-
ities” on page 5 - 1 and “Upgrading The Computer” on page 6 - 1. You may
find the notes marked with a 2 of interest to you.

Beginners and Not-So-Advanced Users

If you are new to computers (or do not have an advanced knowledge of them)
then you should try to look through all the documentation. Do not worry if you
do not understand everything the first time. Keep this manual nearby and refer
to itto learn as you go. You may find it useful to refer to the notes marked with
a /2 as indicated in the margin.

Introduction

4

Notes

Check the light colored
boxes with the mark
above to find detailed
information about the
computer’s features.

Overview 1 - 1



Introduction

Warning Boxes

No matter what your level please pay careful attention to the warning and safe-
ty information indicated by the 27X symbol. Also please note the safety and
handling instructions as indicated in the Preface.

Not Included

Operating Systems (e.g. Windows XP etc.) have their own manuals, as do ap-
plications (e.g. word processing, spreadsheet and database programs). If you
have questions about the operating systems or programs then please consult
the appropriate manuals.

System Software

Your computer may already come with system software pre-installed. Where
this is not the case, or where you are re-configuring your computer for a dif-
ferent system, you will find this manual refers to the following operating sys-
tems:

» Windows 2000 (with Service Pack 4 included)
» Microsoft Windows XP Professional & Home Editions

1 - 2 Overview
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Quick Start Guide

This guide assumes that you are already familiar with computers and can tell /

at a glance what and where all the key components are. If you are not that com- Peripheral Devices

for'gable_with this ty_pe of device, then please refer to the following pages, Please note that pe-

which give an overview of the system. ripherals (printers, dig-
ital cameras, etc.)

It is still best to review these steps, before taking any action. If there is any- | Which attach to your

. . computer by USB
thing you are not sure about, then please refer to the appropriate chapter before S [0 [ GETTEE

continuing. ed after Windows is
up and running. All oth-
Unless you need to install an operating system, your computer should be ready er peripherals must be
to work right out of the box. Before you begin please follow the safety instruc- | Sonnected before you
. . turn on the system.
tions in the Preface.

=

Remove all packing materials.

2. Securely attach any peripherals you want to use with the computer (e.g.
keyboard and mouse) to their ports.

3. Attach the AC adapter to the DC-in jack at the rear of the computer (see
“Rear View” on page 1 - 19), then plug the AC power cord into an outlet,
and connect the AC power cord to the AC adapter.

4. Raise the LCD Swivel Screen to a comfortable viewing angle.

Press the power button to turn “On”.

o

Quick Start Guide 1 - 3
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System Map

Your computer has a lot of built-in features. Most of these are enabled by your
operating system. Further explanations of the various subsystems are covered
in the chapter or pages indicated.

Model Differences

This notebook series includes two different model types. Model A includes a
Touch Panel screen, Model B does not. The specifications for each model are
listed in “Model A Specifications” on page B - 1 and “Model B Specifica-
tions” on page C - 1.

In addition both Model A and Model B have two different designs as pictured
on the following page.

L_________________________________________________________________________________________________________________________________________________|
1 - 4 System Map



Introduction
Getting to Know Your Computer

The following graphics will help you to become familiar with the basic func- ;ﬂ;
tions, and to learn the location of the various ports and components of your -
computer. Design Differences

This manual refers to
the two notebook de-
signs pictured on this
page.

The designs vary
slightly in external de-
sign. Photographs
used throughout this
manual are of Design .

Figurel-1
Design Differences

SystemMap 1 -5
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Figure1-2
Top View with LCD
Panel Closed

1. LCD Latches
2. LED Indicators

1 -6 Top View

Top View

L e

To open the LCD display:

1.
2.

oar®

Place the computer on a stable surface.

Press the latches in the direction of the arrows @ (press in) to release the
top cover.

Lift the top cover to reveal the LCD Swivel Screen and keyboard.

Adjust the LCD Swivel Screen to a comfortable viewing angle.

The LED indicators @ show the power and battery status of the computer.
If you wish to operate the computer in Tablet Mode see page 1 - 7.




Introduction

The LCD Swivel Screen

You can use the computer either in Notebook Mode, or in Tablet Mode. To
put the computer into Tablet Mode:

1. Unlock the LCD side hinges @ & @ by moving them in the direction of the
arrows.
2. Carefully rotate the LCD fully in the direction indicated by the arrow @), then
lock the side hinges @ & @.
3. Move latches @ & @ in and to the left (if they are not already in this
position), then push the LCD down to lock it in position. Figure1-3
— 4 \ Rotating the LCD
Swivel Screen

The LCD Swivel Screen 1 - 7
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Figurel-4
Top View with LCD
Panel Open

Top View with LCD Open

1. Built-In PC Camera

(Optional)

LCD Swivel Screen

LED Power

Indicators

Cover Sensors

LCD Swivel Hinge

LCD Side Hinges

Power Button

Speakers

Keyboard

0. TouchPad and
Buttons

11. Built-In Microphone

wn

BoOoxo~NO O~

1 - 8 Top View with LCD Open



PC Camera

If you have purchased the optional PC Camera, make sure you install the soft-
ware application (see pages 4 - 12, 4 - 19 & 3 - 26).

LCD Swivel Screen

The computer comes with a TFT (Thin Film Transistor), Liquid Crystal Dis-
play screen (see “LCD” on page B - 1/“LCD” on page C - 1 for details). The
screen can rotate and tilt for best visibility in Notebook Mode, and flip for use
in Tablet Mode. The screen may be rotated as long as the driver is installed
(see “What to Install” on page 4 - 2) to appear in Landscape Mode or Por-
trait Mode by means of the VGA Rotate Application or “Q” Hot-Key (see
“Screen Rotation” on page 3 - 4).

The screen also acts as a Touch Panel (Model A only) when the driver is in-
stalled (see pages 4 - 13 & 4 - 20). You can use the stylus pen provided to point
directly to objects on the screen in much the same way as you would use your
mouse as the pointing device (see “Touch Panel (Model A Only)” on page 2
- 19).

LED Power Indicators

These indicators display the system power status, and battery status of the
computer (see “LED Power Indicators” on page 2 - 5).

Top View with LCD Open 1 - 9

Introduction

2N\
2 &

Touch Panel Input
Device

Do not use any sharp
or pointed objects as
your input device e.g.
the end of a pen or
pencil. You should only
use the provided stylus
pen (PDA type) as
your input device.

Screen Rotation

Make sure the screen
rotation driver (see

) is installed
before attempting to
rotate the screen.

GE
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Cover Sensors

7£l< These switches act as sensors to tell when the LCD Swivel Panel is closed, in

Lid Button Notebook Mode, or in Tablet Mode.

It is recommended that
you set the lid (left Mode Left LCD Cover Sensor Right LCD Cover Sensor
LCD cover sensor)

power button to “Do Notebook Press the left LCD cover sensor to Press and hold the right LCD cover

nothing”. Mode trigger the default power saving state sensor, and simultaneously press/tap
(LCD Open) (“When | close the lid of my portable the “Q” key to trigger the functions as

This will prevent acci- computer”). per “Q Key Functions” on page 2 - 16.

dentally triggering a Notebook | Close the LCD to automatically trigger

power saving mode Mode the default power saving state (“When | N/A

when you rotate the (LCD Closed) | close the lid of my portable computer”).

LCD swivel screen.
If the LCD is fully locked down, the right

LCD cover sensor will be depressed

Tablet Mode N/A automatically. Press/tap the “Q” key to

trigger the functions as per “ Q Key
Functions” on page 2 - 16.

Tablel-1
Cover Sensor
Functions

See Lid in Figure 3 - 14 on page 3 - 23 for information on setting the power
saving state. See the sidebar for the power scheme setting recommendation.

.|
1 - 10 Top View with LCD Open
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LCD Swivel & Side Hinges

Release the side hinges in the direction indicated by the arrows on the top pan-
el, and swivel the LCD panel in the direction indicated on the top panel.

Power Button Q)

Press this button to turn your computer On or Off (see “Turning on the
Computer” on page 2 - 4). This button may also be used as a suspend/resume
key, once configured as such in the power management control panel of your
operating system (see “Configuring the Power Button™ on page 3 - 23).

4

Shutdown
Forced Off

Please note that you should always shut your computer down by choosing the Shut
Down/Turn Off Computer command from the Start menu in Windows. This will

help prevent hard disk or system problems. 1T Sy g,

and the Ctrl + Alt + Del
key combination

doesn’t work, press the

Stereo Speakers power button for 4 sec-
onds, or longer, to

Two built-in speakers provide rich, stereo sound. force the system to
turn itself off.

.|
Top View with LCD Open 1 - 11
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Keyboard

The computer has a “Win Key” keyboard including an embedded numeric
keypad. It has the same features as a full-sized desktop keyboard and can eas-
ily be replaced with a different language keyboard should you desire.

TouchPad & Buttons

The pointing device features a sensitive glide pad for precise movements. It
functions the same way as a two-button mouse. The right TouchPad button is
the same as the right mouse button; the left TouchPad button is the same as
the left mouse button (see “TouchPad and Buttons/Mouse” on page 2 - 25).

ﬁ% Microphone

Record on your computer with the built-in microphone.

.|
1 - 12 Top View with LCD Open
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Figure1-5
Front View

1. LCD Latches

2. Microphone-In Jack

3. Headphone-Out
Jack

4. |Infrared
Transceiver

5. Scroll/Enter Wheel

6. LED Status

Front View

Infrared Communication

The Infrared transceiver operates on a “Line of Sight”. Make sure nothing is block- .
ing the “Line of Sight” between your system'’s transceiver and the destination’s Indicators
transceiver. 7. Three Hot-Key
Buttons (Esc, Tab,
& “Q” Rotate)

LCD Latches
Press the LCD latches in to release the LCD panel (see page 1 - 6).

Microphone-In Jack

Record on your computer with an external microphone (the microphone-in
jack is colored pink).

. |
Front View 1 - 13
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(PBETET

1 - 14 Front View

Headphone-Out Jack

Headphones may be connected through this jack (the headphone-out jack is
colored green). Note: Set your system’s volume to a reduced level before con-
necting to this jack.

Infrared Transceiver

The infrared transceiver enables communication between the computer and
another similarly equipped device, and is 4M bps FIR, IrDA 1.1 compliant.
See “Configuring the Infrared Transceiver” on page 2 - 26 for further infor-
mation, and also refer to the manual of the device you wish to connect.

Scroll/Enter Wheel

The wheel key works as a scrolling key (in much the same way as the key-
board arrow keys) if moved to the left or right. If you push the key in it will
act as an Enter/Return key.

LED Status Indicators

These display the system’s operational status. Refer to “LED Power Indica-
tors” on page 2 - 5 for more information on what the lights mean.



Introduction
Hot-Key Buttons

The three Hot-Key buttons include Tab & Esc keys (these keys are particu- 7&(
larly useful in Tablet Mode), and a “Q” key (which also acts as a power but-
ton) to rotate the screen between Portrait and Landscape modes (see “Q Key
Functions” on page 2 - 16 for full details).

Playing DVD’s/VCD’s
and Screen Rotation

If you are playing a
DVD/VCD video, do
not rotate the screen

while playing the vid-
eo. If you wish to rotate
the screen quit the
player program first,
rotate the screen, then
open the player to play
the video.

Front View 1 - 15
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Figure1-6
Left Side View

1. Security Lock Slot
2. Vent
3. Stylus Pen Holder

+3€3

PR
Overheating

To prevent your com-

puter from overheating
make sure nothing
blocks the vent/fan in-
take while the comput-
erisin use.

1 - 16 Left Side View

Left Side View

Security Lock Slot

To prevent possible theft, a Kensington-type lock can be attached to this slot.
Locks can be purchased at any computer store.

Vent
This enables airflow to prevent the computer from overheating.

Stylus Pen Holder
Keep the stylus pen in this holder when not in use.
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Figure1-7
Right Side View

Right Side View

1. 4-in-1 Flash Card
Reader

4-in-1 Flash Card Reader 2. Two USB 2.0 Ports
3. PC Card Slot

The card reader allows you to use four of the most popular digital storage
cards. See “4-in-1 Card Reader” on page 2 - 14 and note the driver installa-
tion information in the sidebar. The formats that can be read include:

* MMC (MultiMedia Card)
» SD (Secure Digital)

* MS (Memory Stick) N/
* SM (SmartMedia Card) ’Q\

Flash Card Reader
Driver

/ Make sure you install
the ENE-PCMCIA
driver as this includes

External CD devices (e.g. CD-ROM drives, DVD-ROM drives, CD-RW drives and support for the Card
Reader (see

External CD Devices

Combination drives) may be plugged in to either of the USB ports.

).

Right Side View 1 - 17
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. e | Two USB 2.0 Ports
These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for
/ low-speed peripherals such as keyboards, mice or scanners, and for high-
speed peripherals such as external DVD devices, CD devices, HDDs, digital
Optional USB 2.0 CD video cameras or high-speed scanners etc. Devices can be plugged into the
Device computer, and unplugged from the computer, without the need to turn the sys-
If your purchase in- | temoff (if the power rating of your USB device is 500mA or above, make sure
cludes the external you use the power supply which comes with the device).
USB 2.0 CD Device,
you can connect it to PC Card SIOt

any USB port.

v P! The 3.3V/5V slot may be used for a Type-11 PC Card (PC Cards were also pre-
viously referred to as PCMCIA) and fully supports Cardbus. Refer to “PC
N2 Card Slot” on page 2 - 15 for more information.

RS

USB Cables

Make sure that your
USB cable connector
is orientated the cor-
rect way before insert-
ing it into the USB Port.
It will only fit one way
(don’t force it).

1 - 18 Right Side View
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Figure1-8
Rear View

Rear View

=

External Monitor
(VGA) Port

RJ-45 LAN Jack
RJ-11 Phone Jack
DC-In Jack

Vent

agrLN

Overheating

To prevent your computer from overheating make sure nothing blocks the vent/fan
intake while the computer is in use.

External Monitor (VGA) Port

Connect an external monitor to this port to allow dual video or simultaneous
display on the LCD and external monitor (see “Display Devices” on page 3 -
11).

RJ-45 LAN Jack

This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

Rear View 1 - 19
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RJ-11 Phone Jack

This port connects to the built-in modem. You may plug the telephone line di-
rectly into this RJ-11 telephone connection.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

_— DC-In Jack
Plug the supplied AC adapter into this jack to power your computer.

Vent
This enables airflow to prevent the computer from overheating.

. |
1 - 20 Rear View
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Bottom View Figure 1- 9

Bottom View

1. Stylus Pen Holder
2. Battery
The CPU is not a user 3. Wireless LAN
serviceable part. Module Cover
Opening this compart- 4. Hard Disk Cover
ment, or accessing the 5. RAM Cover
CPU in any way, may 6. CPU Cover
violate your warranty. 7. Vent

2 &

Overheating

Stylus Pen Holder To prevent your com-

The stylus pen fits in this holder. puter from overheating
make sure nothing

Battery blocks the vent/fan in-

See “Battery Information” on page 3 - 24 for information on battery use and frkg ;’:]’hlllseethe comput-
care.

Bottom View 1 - 21
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Wireless LAN (Network) Module

7£l< The computer’s 802.11b Wireless LAN module, and its antenna and other
Wireless Device components, are not externally visible (please check with your service repre-
Operation Aboard sentative). Make sure you install the driver (see pages 4 - 11 & 4 - 17). Make
Aircraft sure the wireless module is OFF when you are using the computer aboard
The use of any porta- aircraft (see sidebar note).
ble electronic trans-

mission devices Hard Disk Drive
aboard aircraft is usu-

ally prohibited. The internal hard disk drive is used to store your data. See page 6 - 4 for in-
formation on upgrading/replacing your hard disk drive.

2N
I

Drive Warning

Make sure the module
is OFF if you are using

the computer aboard
aircraft.

When your computer
‘Boots Up’ the module
will be ON.

Don't try to remove the hard disk (HDD) while the system is on. This could cause
data loss or damage. Unauthorized removal or tampering with the HDD may violate
your warranty. If you are in doubt, consult your service representative.

To toggle power to the
WLAN module use the
key combination Fn + Vent

F11, or the This enables airflow to prevent the computer from overheating.

1 - 22 Bottom View



Chapter 2: Using The Computer

Overview
To learn more about using your computer, please read this chapter.

This chapter includes:

» The Power Sources

Turning on the Computer

The LED Indicators

The Hard Disk Drive

The Floppy Disk Drive (Optional)
CD/DVD Device (Optional)

4-in-1 Card Reader

The PC Card Slot

The Hot-Keys

The Keyboard

The Touch Panel

Handwriting Application (Optional)
The TouchPad & Buttons/Mouse
Configuring the Infrared Settings

» Adding a Printer (General Guidelines)

Using The Computer

Overview 2 - 1



Using The Computer

The Power Sources
Z The computer can be powered by either an AC adapter or a battery pack.

Power Button as

Standby or Hibernate AC Adapter
Button

Use only the AC adapter that comes with your computer. The wrong type of

Fully  ACPI-compliant §  AC adapter will damage the computer and its components.
OS'’s such as Windows

XP/2000 can use the o
“Power Options” con- 1. Attach the AC adapter to the DC-in jack at the rear of the computer.

trol panel to set the 2. Plug the AC power cord into an outlet, and then connect the AC power cord

power button to send to the AC adapter.

the system into Stand- 3. Raise the LCD Swivel Panel to a comfortable viewing angle.
by or Hibernate mode 4. Press the power button to turn “On”.

(see your OS’s docu-

mentation, or “ Config-

uring the Power

Button” on page 3 -

23 for detalils).

. |
2 - 2 The Power Sources



Battery

The battery allows you to use your computer while you are on the road or an
electrical outlet is unavailable. Battery life varies depending on the applica-
tions and the configuration you're using. To increase battery life, let the bat-
tery discharge completely before recharging.

We recommend that you do not remove the battery. For more information on
the battery, please refer to “Battery Information” on page 3 - 24.

Recharging the Battery with the AC Adapter

The battery pack automatically recharges when the AC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it
will take several hours to fully recharge the battery. When the computer is
turned off but plugged into an electrical outlet, battery charge time is less. (Re-
fer to “LED Indicators” on page 2 - 5 for information on the battery charge
status, and to “Battery Information” on page 3 - 24 for more information on
how to maintain the battery pack.)

Proper handling of the Battery Pack

* DO NOT disassemble the battery pack under any circumstances

* DO NOT expose the battery to fire or high temperatures, it may explode
* DO NOT connect the metal terminals (+, -) to each other

Using The Computer

2NZ
/ﬂ\
Low Battery Warning

When the battery is
critically low, immedi-
ately connect the AC

adapter to the comput-
er or save your work,
otherwise, the un-
saved data will be lost
when the power is de-
pleted.

. |
The Power Sources 2 - 3




Using The Computer

Turning on the Computer
Z " Now you are ready to begin using your computer. To turn it on simply press
Shutdown the power button on the front panel.
Note that you should . .
always shut your com- When the computer is on, you can use the power button as a Standby/Hiber-
puter down by choos- nate/Shutdown hot-key button when it is pressed for less than 4 seconds

ing the Shut Down/ (pressing and holding the power button for longer than this will shut the com-
puter down). Use Power Options in the Windows control panel to configure

Turn Off Computer
command from the ;
Start menu in Win- this feature.
dows. This will help
prevent hard disk or
system problems.

4

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press
the power button for 4 seconds, or longer, to force the system to turn itself off.

If the computer is in Tablet Mode you can use the “Q” Hot-Key as a power
button (see “Q Key Functions” on page 2 - 16 for full details).

.|
2 - 4 Turning on the Computer



Using The Computer

LED Indicators

There are two sets of LED indicators (LED Power Indicators and LED Sta-
tus Indicators) on your computer that will display helpful information about
the current status of the computer. The LED Power Indicators are also visi-
ble when the top of your computer is closed (in Notebook Mode).

LED Power Indicators

Icon Color Description
Table2-1
Orange The AC Adapter is plugged in LED Power
Indicators
‘ I ' Green The computer is on
Blinking Green The computer is in standby mode
Orange The battery is being charged
E Green The battery is fully charged
Blinking Orange The battery has reached critically low power status

LED Indicators 2 - 5



Using The Computer
LED Status Indicators

Icon Color Description
Table 2 - 2
LED Status (((x))) Green The WLAN Module is On
Indicators
U: Green Hard Disk/System activity
@ Green Number Lock is activated
() Green Caps Lock is activated
Green Scroll Lock is activated (to activate press Fn & ScrLk)

2 - 6 LED Indicators



Hard Disk Drive

The hard disk drive is used to store your data in the computer. The hard disk
can be taken out to accommodate other 2.5" IDE hard disk drives with a height
of 9.5 mm.

The hard disk @ is accessible from the bottom of your computer as seen be-
low. Further details on removing and inserting the hard disk are available in
“Upgrading the Hard Disk Drive” on page 6 - 4.

- Hard Disk

Using The Computer

SE
A

Power Safety

Before attempting to
access any of the inter-
nal components of
your computer please
ensure that the ma-
chine is not connected
to the AC power, and
that the machine is
turned off. Also ensure
that all peripheral ca-
bles, including phone
lines, are disconnected
from the computer.

Figure2 -1
Hard Disk Location

Hard Disk Drive 2 - 7




Using The Computer

The Floppy Disk Drive (Optional)

’Q\ The optional external 1.44 MB, 3.5" USB floppy disk drive can connect to

Media Warning any of the USB ports on the computer. By default it is drive “A:” and can be
S T i e used as a boot device if properly set in the BIOS (re_fer to_“Boot Device_: (Star-
floppy disk while the tup Menu)” on page 5 - 9). If your purchase configuration does not include

system is accessing it. this option you can purchase a USB floppy disk drive from a computer store.
This may cause the
computer to ‘“crash”
and damage your data.

Inserting/Removing Floppy Disks

When using the floppy drive, always insert your floppy diskette with the label-
side facing up. To remove the inserted diskette, press the eject button on the
top-right corner of the floppy drive.

.|
2 - 8 The Floppy Disk Drive (Optional)



Using The Computer
CD Device/DVD Device (Optional)

The optional external CD/DVD Device is USB 2.0 compliant and can connect /

to any of the USB ports on the computer. If your purchase configuration does Optional CD Device

not include this option you can purchase a USB CD/DVD Device from a com- with Desktop
Computers

puter store.

You can use the CD

device with desktop
computers without the
AC power adapter (the

. power switch should
Power Switch be set to USB).

AC Adapter

USB 2.0 Cable

Busy Indicator Figure 2 - 2

External CD Device
Open Button

Emergency Eject Hole Headphone Jack

When used with your computer the device must be powered by an AC power
source via the AC adapter. When used with the AC adapter make sure the
power switch is set to EXT (external power).

CD Device/DVD Device (Optional) 2 - 9



Using The Computer
Il, Optional CD/DVD Device Options

AN The optional external CD device is available in CD-ROM, or DVD-ROM, or
Playing Audio CD’s CD-RW, or Combination CD-RW and DVD-ROM drive configurations. The
in Windows 2000 CD Device is usually labeled “Drive D:”, and may be used as a boot device if
To play audio CD's in properly set in the BIOS (“Boot Device (Startup Menu)” on page 5 - 9).
an external USB CD
Device, follow this pro- Enable CD Audio for Windows 2000 USB CD Device

Cedure: . Device Manager i - EI -
Go to Device Manager [acter wow || & o |8 e |2 ] : |
(see step 1 of the =2 ROVTZOOCHEW
) . E:I"R% Batteries
Touch Panel driver in- -] Computer
Sta”ation inStrUCtiOnS E] Dlskivee 5 These settings determine the way in which Windows uses this

CO-ROM for playing CO musiz.

on page ) and
click “+" next to DVD/
CD-ROM Dirives.

Double-click the de-
vice and select the

— CD Player%olume
: - 1 ' ' ' ' ' ' ' ' '
£- % IDE ATA,I’ATF\PI controllers j High
£ Imaging devices
-8 Infrared devices

Keyhnards —Ngital CO Playback

2}
3}
H-T7y Mice and other pointing devices
3}
3}

Properties tab.
- Modems You o have Windows use digital instead of analog playback of CD

E

[

E

[

E:

[

E

Make sure thel‘e iS a -3 Monitors feature may not work with all CD-ROM devices, disable if you

£ oblems with CD audio.
[

E

[

E:

[

[

tick in the “Enable digi- A Neonel ol L

. ) +- 4y PCMCLA adapters
tal CD audio for this £, Ports (COM & LPT) < ¥ Enable digkl CD audi for this CD-HDM:ISD
]--g@ 5C3I and RAID controllers

CD-ROM deV|Ce. #-¢}|= Sound, video and game controllers

ol System devices
#-85 Universal Serial Bus controllers

Figure2 -3
Enable CD Audio =

2 - 10 CD Device/DVD Device (Optional)



Loading CDs or DVDs

To insert a CD/DVD, press the eject button and carefully place a CD/DVD
onto the disc tray with label-side facing up (use just enough force for the disc
to click onto the tray’s spindle). Gently push the CD/DVD tray in until its lock
“clicks” and you are ready to start. The LED indicator will light up while data
is being accessed, or while an audio/video CD, or DVD, is playing. If power
is unexpectedly interrupted, insert an object such as a straightened paper clip
into the emergency tray release hole to open the tray.

Handling CDs or DVDs

Proper handling of your CDs/DVDs will prevent them from being damaged.
Please follow the advice below to make sure that the data stored on your CD-
ROMSs/DVD-ROMs can be accessed. Remember to:

» Hold the CD or DVD by the edges; do not touch the surface of the disc.
» Use aclean, soft, dry cloth to remove dust or fingerprints.

» Do not write on the surface with a pen.

» Do not attach paper or other materials to the surface of the disc.

* Do not store or place the CD or DVD in high-temperature areas.

» Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
» Do not bend the CD or DVD.

» Do not drop or subject the CD or DVD to shock.

CD Device/DVD Device (Optional) 2 - 11

Using The Computer

2NZ
/ﬂ\
CD Emergency Eject

If you need to manually
eject a CD (e.g. due to
an unexpected power
interruption) you may
push the end of a
straightened paper clip
into the emergency
eject hole. However
please do NOT use a
sharpened pencil or
similar object that may
break and become
lodged in the hole.
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DVD Regional Codes

DVD region detection is device dependent, not OS-dependent. You can select
your module’s region code 5 times. The fifth selection is permanent. This can-

not be altered even if you change your operating system or you use the module
with another computer.

Figure 2 - 4 .
g | Properties | DYD Rlegion | Valumes
DVD Reg 1on al Mosgt DWDe are encoded for play in specific regions. To play a
COd es regionalized DD on your computer, you must set pour DYD dive to
play d.is-:s.from that region by zelecting a geographic area from the
(Wl ndows XP) following list.

CAUTION *fou can change the region a limited number of times.
After Changes remaining reaches zero, pou cannot change the region even
if pou reinstall Windows or move pour DVD drive to a different computer.

Changes remaining: 3

To change the curent region, select a geographic area, and then click OK.

Afghanistan Al
Albania |
Algeria
American 5amoa
Andona
Angola
Anguilla w

Currert Region:  [Region 2
MHew Region:

[ ak l ’ Catcel

2 - 12 CD Device/DVD Device (Optional)
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Changing DVD Regional Codes
Go to the Control Panel in WindowsXP/Windows 2000 and double-click Sys-
tem > Hardware (tab), click Device Manager, then click the + next to DVD/

CD-ROM drives. Double-click on the DVD-ROM device to bring up the

Properties menu, and select the DVD Region (tab) to bring up the control

panel as seen in “DVD Regional Codes (Windows XP)” on page 2 - 12.

DVD Regional Coding
Region Geographical Location Table 2,' 3
DVD Regional

1 USA, Canada Coding
2 Western Europe, Japan, South Africa, Middle East & Egypt
3 South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong

Kong
4 South & Central America, Mexico, Australia, New Zealand
5 N Korea, Russia, Eastern Europe, India & Most of Africa
6 China

CD Device/DVD Device (Optional) 2 - 13
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~ 4-in-1 Card Reader
The 4-in-1 Card Reader allows you to use four of the most popular digital stor-
SmartMedia Cards age cards. Make sure you install the ENE-PCMCIA driver as this includes

support for the Card Reader (see “What to Install” on page 4 - 2).

Note that SmartMedia
Cards should be in-
serted as illustrated in
Figure 2 - 5.

Figure2-5
4-in-1 Card Reader
(With SmartMedia

Card)

To read from the card, simply insert the card into the slot and it will appear as
a removable device. Formats that can be read include:

* MMC (MultiMedia Card)
» SD (Secure Digital)

e MS (Memory Stick)

¢ SM (SmartMedia Card)

2 - 14 4-in-1 Card Reader
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PC Card Slot ~
The computer is equipped with a PCMCIA 3.3V/5V slot for one type 1l PC "
Card. Make sure you install the driver for the PC Card (see “What to Install” Conserving Battery
on page 4 - 2). FoEr
_ ) To conserve battery
Inserting and Removing PC Cards power remove any un-
» Align the PC Card with _the slot and push_ it in until it locks into place. :’hS: d cpocmsuﬁs fzgrg
» Toremove a PC Card, simply press the eject button @ next to the slot. Cards quickly use up

battery power even if
the system enters
sleep mode).

Figure 2 - 6
PC Card Slot

. |
PC Card Slot 2 - 15
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> Hot-Keys

The four Hot-Key buttons include Tab & Esc keys (these keys are particularly

Right Cover Sensor useful in Tablet Mode) and a wheel key for scrolling/Enter key functionality.
The right LCD cover (Move the wheel left or right for scrolling functions in much the same way as
sensor (see “Cover the keyboard arrow keys; push the wheel in for Enter/Return functions.) In

Sensors” on page 1 - Tablet Mode the “Q” key is used to toggle the screen rotation between Land-
tlu()?] "T'N ﬁf]ef'hg‘ fQO,r,‘“J(‘)Ct: scape and Portrait configurations; it also acts as a power button. The table
Key to tell the compu- below lists the function options depending upon the time duration the key is

ter when it is in Tablet pressed (see sidebar for use in Notebook mode).
mode (when the com-
puter is in Tablet mode

.the HGULE DU Sl Power “Q” key function Time Pressed

is depressed). State

If you are in Notebook

mode you can perform On Rotate Screen Tap (do not press) for less
the same set of func- than 0.8 seconds

tions listed in the table
by tapping/pressing
the “Q” key and press- On
ing the right cover sen-
sor simultaneously.

Initiates the default setting of OS’s power
scheme (Power Button) - “When | press | More than 0.8 seconds but

the power button on my portable computer” less than 4 seconds
- (see Figure 3 - 14 on page 3 - 23)

On System Shutdown More than 4 seconds

Table 2 -4
Q Key Functions

Off System Power On N/A

2 - 16 Hot-Keys
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The Function Keys

On the bottom-left of the keyboard is the Fn key, or Function key, which al-
lows you to change operational features instantly. To use the functions press
and hold the Fn key, and then press the appropriate function key (F3 - F11
etc.) located on your keyboard.

N
Function Keys Description 7&(

Fn+F3 Mute Toggle Wireless Device Operation
Aboard Aircraft

Fn+F4 Sleep Toggle

The use of any portable electronic
Fn+F5 Decrease Audio Volume transmission devices aboard aircraft is

usually prohibited.

Fn + F6 Increase Audio Volume . .
Make sure the module is OFF if you are
Fn + F7 Display Toggle using the computer aboard aircraft.
- When your computer ‘Boots Up’ the
Fn + F8 Decrease LCD Brightness module will be ON.
Fn+ F9 Increase LCD Brightness To toggle power to the WLAN module
- use the key combination Fn + F11, or
Fn+ F11 Wireless LAN Module On/ the

Off Toggle

The Keyboard 2 - 17
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Other Keyboards

If your keyboard is
damaged or you just
want to make a
change, you can use
any standard USB key-

board. The system will
detect and enable it
automatically. Howev-
er special functions/hot
keys unique to the sys-
tem’s regular keyboard
may not work.

Table2-5
Function Keys
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Special Characters

Some software appli-
cations allow the
number-keys to be
used with Alt to pro-
duce special charac-
ters. These special
characters can only be
produced by using the
numeric keypad. Reg-
ular number keys (in
the upper row of the
keyboard) will not
work. Make sure that
Num Lock is on.

Figure 2 -7
Keyboard

2 - 18 The Keyboard

Numeric Keypad
The keyboard has an embedded numerical keypad for easy numeric data input.

Activate the Number Lock feature by pressing the Fn and Num Lk key com-
bination. You may check if Number Lock is enabled or not by looking at the
LED status indicators (see “LED Indicators” on page 2 - 5). To type a num-
ber from the numeric keypad make sure Num LK is enabled, and then press
the key on the numeric keypad. (To type a letter from the numeric keypad if
Num LKk is enabled, hold down the Fn key and press the appropriate letter

key.)

Activate Scroll Lock by pressing the Fn and Scr Lk key combination.

= AT
A 2 M o |
_““*J[L e IF HL\JEL* PRomere Koyont |
— UQ;ML I g L_\_U ) S
CESN |GGG H@Lﬂﬂ_‘;’i

CEFET T

'\
Num Lk &
Scr Lk Keys
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Touch Panel (Model A Only) Y
If your computer is Model A the LCD screen also acts as a Touch Panel S
when the driver is installed (see pages 4 - 13 & 4 - 20). Use the stylus pen pro- TOUChDFe’f/‘?Ce; Input

vided to point directly to objects on the screen in much the same way as you
would use your mouse as the pointing device.

(Model A Only)

] ) Do not use any sharp
A new icon (¥ or &) will appear in the taskbar (if you do not see the icon or pointed objects as
go to the Touch Panel control panel and click the tickbox to display the icon your input device e.g.
in the taskbar - see Figure 2 - 9) after you install the Touch Panel driver. Click theencﬁnioﬁfsﬁoﬁzr:m?r
this icon to switch your provided stylus pen to act as a left or right mouse but- 533 the provided Sty,ui
ton. The Touch Panel control panel allows you to configure the input options pen (PDA type) as
from the Touch Panel Set-Up and Configuration Utility (see over for screen your input device.

examples). Make sure you calibrate the Touch Panel.

Pay particular attention
- ald; to the area at the edge

O -0 3| s e |- ‘ of the screen where

il

SIS crwares § the LCD meets the
W _'J k&h Add Hardhmare ;lhw Admirntatiee Dale and Time Digilary’ frame (See page
(@ 5witch to Casegery View Tosens T
R s W B e P = O T
R s o oty For Gane onerar
W) Heb and Support . x .
22523 Figure 2- 8
¥ @ 7 A\ 2w Touch Panel
TSRS o Control Panel
4

Touch Panel (Model A Only) 2 - 19
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Touch Panel
Calibration

Make sure you cali-
brate the Touch Panel
from the Touch Panel
Set-Up and Configura-
tion Utility.

1.Click the Calibra-
tion tab.

2.Click the Calibrate
Now button.

3.Use the input device
to touch the cross at
the different posi-
tions on screen.

4.Click the Update
button.

Figure2-9
Touch Panel
Set-Up and
Configuration
Utility

# Tauch panel set-up and confaperation utiliy —=aF. ]
| | Cobaon
Toeh Parel Touzh spermen st
e mode| " Portmode
Doz rterval trve
St wpm * 5 fra) @31 bsl w5
et vse: & ETHIR| i
$® ¥ Diaplay the icon e sk bar-

Aot lemtia e | Teahersmame | Coee
Tt

Cox ] e | oo |

# eusch paned uet-up and configuraten utily

Touch Farel

| | *oush coermen sfln 1
Teuch Pansl cortrolar fasturme

7 Lise mrfssant EEPROM in o rafivation oty

# tuuh pand vl up amd conligeaten sty i}
Touch Farel 1 Touch cpmsten wtio
‘ | | cotroon
2 P Lotz
YA Y
oep mvabied e dantied itisliges
T
E T s ke
g A | 2
-
o8 pis) Bewp e 1 1000w
Beenime % ) o 2| |
ok | owen | ass
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Touch Panel Warning

Be very careful not to press too hard with the stylus pen when using it as the input
device. Use only the approved stylus pen provided. When writing on the screen,
avoid sliding the stylus pen (or any object) in the area around the edge of the screen
(between the LCD and the frame).

Using The Computer

SE
A

Touch Panel Input
Device
(Model A Only)

Do not use any sharp
or pointed objects as
your input device e.g.
the end of a pen or
pencil. You should only
use the provided stylus
pen (PDA type) as
your input device.

Figure 2 - 10
Touch Panel
Warning

Touch Panel (Model A Only) 2 - 21
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ritePen

The ritePen program is
a handwriting recogni-
tion application which
allows you to use the
provided PDA stylus
pen to write text on the
screen. The handwrit-
ing will then be con-
verted into text for use
in any application.

riteMail

The riteMail program is
a note-taking and edit-
ing application which
allows you to export
the notes to applica-
tions e.g as a handwrit-
ten email.

Handwriting Application (Optional)

If your purchase includes the handwriting application you may write on the
screen of your computer, and convert this into text to be entered into any Win-
dows application. The application contains the ritePen and riteMail utilities.
To install the utilities follow this procedure:

ritePen Installation

AR

o

Insert the RiteNotes HandWriter CD into an external CD/DVD device.
Click Start (menu) > Run...

Navigate (Browse..) to D:\ritePen\Setup.exe and click OK.

Click Next > Yes.

Input a User Name and Company Name (you are required to input
something into both fields), and then click Next > Next > Next > Next.
Click Finish.

riteMail Installation

1.
2.

Insert the RiteNotes HandWriter CD into an external CD/DVD device.
Click Start (menu) > Run...

3. Navigate (Browse..) to D:\riteMail\riteMailWinClient.v.2.0.45.cv.exe

ok~

and click OK.

Click Next > Yes.

Input a User Name and Company Name (you are required to input
something into both fields), and then click Next > Next > Next.
Click Finish.

.|
2 - 22 Handwriting Application (Optional)
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ritePen 5

If you do not see the ritePen notification icon & in the taskbar you can open 4 .
the utility by going to the Start menu and pointing to Programs/All Pro-
grams > Parascript > ritePen, and clicking ritePen. The icon will appear in
the taskbar to indicate it is active. Use the input device to click the icon to | Full instructions for

make the utility inactive (the icon will change to ). :’i(t’gl'\/l;';le Jt'itlﬁizgn (r?tl‘f

Help

e . ] . . Pen Help & riteMail
When the notification icon ¥ is enabled you may enter text into any active Help) are available

(make sure the application is in the foreground) text-enabled application by from the Parascript

item in the Programs/

using your input device to write on the screen. The written text will be input
All Programs menu.

into the active screen window when you complete writing.

Figure 2 - 11
Text Input

Handwriting Application (Optional) 2 - 23
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Emailing Notes

Go to the Tools menu
and select Options,
then fill in the User and
Mail setup information
before sending any
notes as emails. Click
the Send button & send
to send the mail.

Figure 2 - 12
riteMail Message

riteMail

Run the riteMail program from the Start menu and pointing to Programs/All
Programs > Parascript > ritePen, and clicking riteMail. You can use the in-
put device to write in the note taking area of the utility, and then select it by
using the Selector ¥ to circle, cross or click the required area (hold the shift
key down to select additional area or choose Select All from the Edit menu).

The selected area may be exported as a picture, or may be converted to text.
To export the selected electronic ink, just copy and paste it into your applica-
tion. To export the selected electronic ink as text, select Copy as Text from
the Edit menu (click OK after the program completes the text recognition)
that can then be pasted into your application.

md Message - riteMail
File Bl ‘iew Tools Window Help

Unda iz B[] L BRI S 7 X0 R YNEYF| -0 W
Mote ¥ cut Ctrl+x

t 4 Send
0 Copy Chrl+C E el
@' Copy as Text e
@E [ paste Ctrl+y
@. Delete Del
@. L
@ Select Al Ctrl+a
8l
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TouchPad and Buttons/Mouse

The TouchPad is a device for pointing (controlling input positioning) on the /
computer’s display screen by sensing finger movement, and downward pres- Mouse Driver
sure. It is an alternative to the mouse; however, you can also add a mouse to .
If you are using an ex-
your computer through one of the USB ports. temal mouse your op-
.. ti t b
The TouchPad buttons function in much the same way as a two-button mouse. | 5" SZSST:O?%WE
Once you have installed the TouchPad drivers (see pages 4 - 10 & 4 - 16) you your mouse during its
can configure the functions by double-clicking the TouchPad driver icon installation or only ena-
on the taskbar. You will find further information at www.synaptics.com. ble its basic functions.
— ; . Be sure to check the
s s e e device’s user docu-
:;;:_ ‘}';-‘_ » _ S mentation for details.
- ||t el s Cr—
c | —— )
A TR e
) [ T | G =
== Aim = 2 .
e | e g Figure 2 - 13
== el = - Mouse Properties
AL e

TouchPad and Buttons/Mouse 2 - 25
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) Configuring the Infrared Transceiver
To configure the computer’s settings for Fast Infrared (FIR) communication
Infrared follow these steps:
Communication
The infrared transceiv- 1. Click Start, point to Settings (or just click Start and click Control Panel)
er operates on a “Line and click Control Panel.
of Sight”. 2. Double-click Wireless Link (in the Printers and Other Hardware

Category) icon.

Click Hardware (tab), and then click Properties (button).

Select Advanced (tab).

Select “Infrared Transceiver A” and change the Value to “IBM 31T1100".
Click OK > OK.

Make sure nothing is
blocking the “Line of
Sight” between your
system’s transceiver
and the destination’s
transceiver.

o gk w

The settings for the infrared transceiver may also be configured in the BIOS
(see “COM Ports (Components Menu)” on page 5 - 13).

For further information, please refer to the manual of the device you wish to
connect.

2 - 26 Configuring the Infrared Transceiver
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Adding a Printer

The most commonly used peripheral is a printer. The following conventions
will help you to add a printer, however it is always best to refer to the printer
manual for specific instructions and configuration options.

USB Printer

Most new printers have a USB interface connection. You may use any of the
USB ports on your computer to connect the printer.

Install Instructions:

1. Set up the printer according to its instructions (unpacking, paper tray, toner/
ink cartridge etc.).

Turn ON the computer.

Turn ON the printer.

Connect the printer's USB cable to one of the USB ports on the computer.
Windows will identify the printer and either load one of its own drivers or ask
you to supply one. Follow the on-screen instructions.

arwd

.|
Adding a Printer 2 - 27
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5 Parallel Printer
This is still a very common type of printer. A Parallel to USB converter may
be purchased at most computer stores.

Install Instructions:

1. Set up the printer according to its instructions (unpacking, paper tray, toner/
ink cartridge etc.).

2. Attach the parallel cable to the printer.

3. Connect the printer’s parallel cable to the Parallel to USB converter, and

then plug the converter into the USB port.

Turn ON the printer.

Turn ON the computer.

6. Windows (some operating systems may require a driver to recognize the
parallel to USB adapter) will identify the printer and either load one of its
own drivers or ask you to supply one. Follow the on-screen instructions.

ok

.|
2 - 28 Adding a Printer
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Chapter 3. Advanced Controls

Overview
This chapter covers:

« Advanced Video Controls Drivers

» Power and Battery Management Features You are unable to use
» PC Camera Module (optional) most advanced con-
+ Wireless LAN Module (optional) trols until the neces-

sary drivers and
utilities are properly in-
stalled. If your system

hasn't been properly
configured (your ser-
vice representative
may have already
done that for you), re-
fer to “What to In-
stall” on page 4 - 2 for
installation instruc-
tions.

Note: All operating system pictures in this manual are from the Microsoft
Windows XP OS.

Overview 3 - 1
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Advanced Video Controls

7£l< This section is about making adjustments for the LCD, and switching display
Protecting the LCD devices.

Do not allow any for-

eign objects (i.e. paper Opening the LCD
or plastic) to get be- As you open the lid, adjust it so you can look at the screen straight on, without
WECIRUERRIRSEREUEEE  any glare. If necessary, adjust the brightness controls (Fn + F8/F9). The Fn +

the work panel. They - . . .
ol chrene o F7 key combination allows you to toggle through display options if you have

e e @ n el a monitor attached (see “Function Key Combinations” on page 3 - 13).

accidentally actiyate
the close cover switch. 1 m gr.mm .[Lm m
! 4, _OJMLM

1_

Figure 3-1
Display Controls

== I I MLJ il
MMMMMMMMMMMDM HM
= T -1
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Video Memory

The computer does not have dedicated video memory. The video memory
available on your computer is configured in two modes of operation.

VGA Shared Memory

This is the pre-allocated memory size for VGA compatibility. This is fixed
in the BIOS at 32MB (see page 5 - 11). This memory is allocated from your
system memory e.g. if you computer has 256MB of memory (RAM), then
32MB will be allocated to video leaving the system with 224MB of RAM.

Dynamic Video Memory Technology

Intel® DVMT automatically and dynamically allocates as much (up to
64MB) system memory (RAM) as needed to the video system (the video
driver must be installed - see “What to Install” on page 4 - 2). DVMT
returns whatever memory is no longer needed to the operating system.

System Memory Maximum Memory Allocated for Graphics by DVMT

OMB - 127MB Not Supported
128 MB - 255MB 32MB
256MB - Maximum Memory | 64MB

Advanced Controls

4

DVMT Notes

DVMT is not user-con-
figurable.

DVMT is not local vid-
€0 memory.

DVMT will not function
in MS-DOS. DOS uses
the legacy memory in-
dicated.

Table3-1
DVMT Memory
Requirements

Video Memory 3 - 3
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Playing DVD’s/VCD’s
and Screen Rotation

If you are playing a
DVD/VCD video, do
not rotate the screen

while playing the vid-
eo. If you wish to rotate
the screen quit the
player program first,
rotate the screen, then
open the player to play
the video.

Figure 3 -2
VGA Rotate
Application

3 - 4 Screen Rotation

Screen Rotation

The screen may be rotated to appear in Landscape Mode or Portrait Mode
by means of the screen rotation driver or “Q” Hot-Key (see “Hot-Keys” on
page 2 - 16). Make sure the screen rotation driver is installed before attempt-
ing to rotate the screen (see the driver installation procedure on pages 4 - 13
& 4-19).

Lut a8 Lt Vared (11170010 e IR SR RS TRl ] -
CoorMmegenens | T iniedly) Caveme Graphics
Genesd | Adspter Mantor i Traubbesheoting

Uncheck this box

to prevent screen M o
rotation problems o
in Windows 2000. e ;
| 2707 [ioE|| 90°] B R
180°]

VGA Rotate Application

Double-click the icon 8 in the taskbar to bring up the screen rotation menu.
Click a button to rotate the screen, or hide the application. You can also use
the buttons to toggle power On/Off to the WLAN module (-, send the com-
puter in to a power saving mode (#== (the same mode as set for the “Sleep But-
ton” on page 3 - 23), or to adjust the brightness of the screen [#.1 . .
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“Q” Hot-Key

In Tablet Mode the “Q” key is used to toggle the screen rotation between 7&(

Landscape and Portrait configurations; it also acts as a power button. Make s o
i~ creen Rotation in

sure you gently tap the “Q” key to get the screen to rotate (do not press the key Windows 2000

for too long or it will initiate a power saving mode). See “Q Key Functions” _

on page 2 - 16 for full details on the “Q” key functions. Wl G IR

tating the screen to 90
or 180 degrees in Win-
dows 2000, follow this
procedure.

Go to the Display
Properties (see

Window.

Click Advanced (but-
ton) and click Monitor
(Tab).

Uncheck the box “Hide
modes that this mon-
itor cannot display.”
(see

).
Click OK and close the
open Windows.

Screen Rotation 3 - 5
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Screen Resolution/
Screen Area Note

You may set the reso-
lution to a higher set-
ting than the panel
supports, however this
will require you to pan
(scroll) around the
screen as the display
area will be larger than
what you can see on
the LCD.

Video Driver Controls

The video interface lets you change the screen resolution and color output to
whatever is most comfortable/efficient for you. This is a matter of hardware,
video memory and the driver for your operating system. The driver interface
shows the available options (see pages B - 1 & C - 1 for LCD information).

You can switch display devices from the Display Properties control panel in
Windows as long as the video driver is installed (see “What to Install” on
page 4 - 2).

Making Adjustments for the Display

The higher the resolution you set the LCD for, the more information the LCD
can display on screen. To change the LCD’s resolution and color depth go to
the Display Properties control panel:

1. Click Start, point to Settings (or just click Control Panel) and click Control
Panel (if you are in Category View choose Appearance and Themes).

2. Double-click Display (icon).

3. Inthe Display Properties dialog box, click Settings (tab).

4. In Screen area/Screen resolution, move the slider to the preferred setting
for resolution (see @ in Figure 3 - 3 on page 3-7).

5. In Colors/Color quality, click the arrow and scroll to the preferred setting
for color depth (see @ in Figure 3 - 3 on page 3-7).

3 - 6 Video Driver Controls
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Display Properties

Display Properties [?] F'gure 3-3 3
| Themes | Desktop | Screen Saver | Appearance | Setings DISpIay Propertles

D'rag the monitor icons bo match the physical arangement of your monitors.

Dizplay: /
|1. Digital Flat Panel (1024:768) an Intel[R) 82852/82855 GM/GME Gr: v|
Screen resolution LColor quality
Intel(R) Extreme
Less "_ Mare - . -
- J N_lfd'um ns'f“]_ __ = Graphics Controller
1024 by 768 pirels I . Properties
iz maritor You can click Graph-
[ Identify ][Iroubleshoot... ] [ Adgancedg ICs Rropertles (bUt'
ton) in the Intel(R)
[ ok [ caneel | e Extreme Graphics 2

for Mobile tab (in the
] ) ] ) Advanced options) to
When the Display Properties control panel is open, click the Advanced @ access the screens in

(button) to bring up the options tabs. Clicking through these tabs allows you Figure 3 - 5 on page

to make any video adjustments you require. 3-9.

Video Driver Controls 3 - 7
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Taskbar

You may also access
the control panel from
the taskbar at the bot-
tom right of the screen.
Click on the icon to
bring up the menu and
scroll to Graphics Op-

tions > Graphics
Properties.

If you cannot see the
tray icon go to the In-
tel(R) Extreme
Graphics 2 for Mobile
tab (in the Advanced
options) and click the
“Show Tray Icon” tick-
box.

Figure 3-4
Intel Extreme
Graphics Control
Panel

Intel Video Driver Controls

After installing the video driver there will be an additional control panel en-
titled Intel(R) Extreme Graphics 2 M. To get to the control panel to make
changes to the Graphics Properties, do the following:

1. Click Start, point to Settings (or just click Control Panel) and click Control
Panel.

2. Double-click Intel(R) Extreme Graphics 2 M (icon) to bring up the Intel(R)
82852/82855 GM/GME Graphics Controller Properties.

Digital Flat Panel (1024x768) and Intel(R) 82852/82... 7]

General Adapter i ? tManitar [l ? Troubleshoot
Color Management | E Intel(R) Extreme Graphics 2 for Mobile

Intel(R] B2852/82855 GMAGME Graphics Controller
6.14.10.3665

Wisit Intel's Corporate 'Weh Site

hittp: A intel com
Download the Latest Intel Software and Drivers

hitp:#/support intel. comysupport/go/downloads
Access the Latest Support Help and Information

Save As Scheme. ..

Graphics Properties...

Qukput To Graphics COptions
Panel Fit Display Modes

extrome  SEEEE
graphICS 2 for mobile

Hot Keys
Tray Icon

3 - 8 Video Driver Controls
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You may make changes to the Devices, Color, and Schemes by clicking the
appropriate tab and adjusting the setting, then clicking OK. The Information
and Open GL tabs display useful information about the graphics properties of
your computer, and the Support item in the Information tab has weblinks to
the latest information (drivers, troubleshooting issues etc.) on the Intel Web-
site. Screen examples are shown on the following page.

Inbadfil] BI85 218 755 CAUCME Graphics Cantralies Py X IntelfH) 87852187055 GAIGML Graphics Contradier Prape... (7|5 Int F i gu re 3 - 5
Divces | Cokn | Schumes | Wt Fs | Mision | DpartL | infomation Davces 043 | Schwme | Hot Koy | Potaon | i | Ibomaten| b .
& = e - Intel Graphics
il |- T ' .-.:i:., Controller Properties
bt [ = b et e

Devces | Coko | Schamar| Hol Kart | Ronsbon | fpentiL Infommation |
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4

Application.exe

You will need to locate
the actual application
executable (.exe) file,
not just the shortcut.
To find the application
right-click its shortcut
on the desktop click
Properties. Click the
Shortcut (tab) and see
where the executable
file is located by click-
ing the Find Target
(button). Note the loca-
tion and you will then
be able to browse to
this file.

Schemes

Use Schemes to configure quick settings for applications that require specific
resolution and color settings in order to run properly e.g. games, multimedia
programs. To set the schemes:

1.

N

Go to the Intel(R) Extreme Graphics 2 M control panel (see “Intel Video
Driver Controls” on page 3 - 8).

Click on Schemes (tab).

Select New to setup the scheme, and type a hame in the dialog box that
pops up, then click OK.

Click on the scheme name you had typed in the Schemes box, and choose
the option you wish to use from the Video Modes box.

Browse to the executable file for the application you want to set a scheme
for (see sidebar).

You can click in the "Reset On Exit" box to return to your original settings
when you exit the program, then click Save to save the settings.

When you want to run the program, select it from the Schemes box and
click "Invoke" to run the highlighted program in the chosen video setting
(alternatively you can select it from Display Modes by clicking on the icon
option in the taskbar at the bottom right of the screen).
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Display Devices

Besides the built-in LCD, you can also use an external monitor as your dis-
play device. A monitor connects to the external monitor (VGA) port @. Figure 3-6
Rear View

4

Using the Driver to

Switching/Enabling Displays (Keyboard) ShaREREE
You can switch display devices with the Fn + Display (F7) toggle. With the If you only use the key-
video driver installed, you also can use its built-in controls to switch the dis- board toggle to switch
play options. If you haven’t installed the video driver, refer to “What to In- :g:g%g;halﬂ'iﬂfﬁs\f’e
stall” on page 4 - 2 for setup instructions. To switch the display options: all the configuration
options available to
1. Plug the monitor into the appropriate port. you. If you want to ac-
2. Press and hold the Fn key, while simultaneously pressing the F7 key. cess the options listed

3. You may toggle through the options to display the LCD only, the external in “Display Devices”
display alone and the LCD and the external display together (make sure you on page 3 - 11 use the
allow time for the screens to refresh as you toggle through).

driver control panel to
configure the settings
as per “Switching/En-
abling Displays (Driv-
er)’ on page 3 - 12.

.|
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4

Vertical Refresh Rate

The vertical refresh rate
of your monitor is impor-
tant. If it is too low and/or
you're using fluorescent
lighting, the screen will
appear to flicker. To re-
duce flickering on a moni-

tor, use faster refresh
rates (we recommend a
refresh rate of 72Hz or
more). But first check
your monitor's documen-
tation to make sure it can
support the rates listed by
the video driver. The de-
fault refresh rate for mon-
itors (without drivers) is

. 60Hz.

Figure 3-7
Switching Display
Settings

Switching/Enabling Displays (Driver)
With the video driver installed (see pages 4 - 9 & 4 - 15), you can use its
built-in controls to switch between the displays as follows:

1.
2.

3.

4.

Plug the monitor into the appropriate port.

Go to the Intel(R) 82852/82855 GM/GME Graphics Controller Properties
control panel (see “Intel Video Driver Controls” on page 3 - 8) and select
Devices (tab).

Choose the display option from the list on the left and click Apply (and OK

to confirm the settings change).

You can choose a device to be Primary or Secondary.

Intel{R) B2B52/B2B55 GMIGME Graphics Controller Prope. .. r;i' |F|

Devices | Cokor | Schemes | HetKeys | DpenL | Infomation |

Dences
4 Prmay Device [Ty -l Confirm Desktop Change
Mankor
r Sconduy Divice [More =l Your desktop has been reconfigured. Do pou want to keep
- these settings?
Lmiin Dervace U
=, If ho responze iz received within 15 seconds these changes
-g will automatically be canceled.
Il Dol | - o B Sk
Diaplay Chone
44 Cancel
Exdercded Deckhop Device Setfingt

Lo o | o |

See the following pages for instructions on enabling Clone and Extended
Desktop modes.
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Multi-Monitor Modes
In addition to the single LCD display mode you have the following Multi-
Monitor modes available when the external monitor is attached.

Intel(R) Dual Display Clone

This mode will drive multiple displays with the same content. Use this feature
to display the screen through a projector for a presentation.

Extended Desktop

This mode allows a desktop to span multiple displays and acts as a large work-
space. This creates a lot more screen area for display. Use the Display Prop-
erties control panel to drag the monitors to match the physical arrangement
you wish to use, or you may also use the Extended Desktop Settings control
panel tab in Intel(R) 82852/82855 GM/GME Graphics Controller Proper-
ties to configure the relative size and position.

Advanced Controls

4

Function Key
Combinations

You can use the Fn +
F7 key combination to
toggle through the dis-
play options:

 LCD Only
e Monitor Only
e LCD + Monitor

Make sure you give the
displays enough time
to refresh.
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Figure 3-8
Device Settings
(Clone Mode)

3 - 14 Display Devices

To Enable Dual Display Clone Mode:

1.
2.

oo

Plug the monitor into the appropriate port.

Go to the Intel(R) 82852/82855 GM/GME Graphics Controller Properties
control panel (see “Intel Video Driver Controls” on page 3 - 8) and select
Devices (tab).

Click the Intel(R) Dual Display Clone icon in the devices tab (Note: this
option is only available when you have attached the monitor).

Choose which device is to be the Primary display, and which is to be
Secondary.

Adjust the settings by clicking the Device Settings (button) if necessary.
Click Apply > OK and close the control panels.

/82855 GMI/GME hics Cantroller Prap

Devices \culm | Schemes | Hot Keys | OpenGL | Infomation | . Notebaok (Primary)
etlings

i Devices )

| ks i r—

= Fiimaty Devics [Notebook ]

Monior SeisenArea oIS =
r S Montor =

Notebook
[ Device Options ™ Full Screen [No Border)

Manitar [Secondaiy]

A’,‘;;:E]ED,D“:; [ Game display configuration diiven on both displays Y Lirae — -
~——

= — e I _




Advanced Controls

To Enable Extended Desktop Mode:

1. Plug the monitor into the appropriate port. /

2. Goto the Intel(R) 82852/82855 GM/GME Graphics Controller Properties
control panel (see “Intel Video Driver Controls” on page 3 - 8) and select
Devices (tab).

Device Settings
Extended Desktop

3. Click the Extended Desktop icon in the devices tab (Note: this option is You can have different
only available when you have attached the monitor). Colors, Screen Area
4. Choose which device is to be the Primary display, and which is to be and Monitor Refresh
Secondary. Rates for each display
5. Adjust the settings by clicking the Device Settings (button) if necessary. device provided your
6. Click Apply > OK and close the control panels. monitor can support
Intel[R) BZB52/B2H5% GAGME Graphics Contratier Prope... [ |[5€] I Device Settings 7% them.
O oo sshabel bt nimc| Mo Mt i Mot eceray) You can drag the mon-
E| s i itor icons to match the
S ok CTEC || | TR - physical layout of your
= | e [oty7es <] | Seeendes [oesmy7ee <] displays. Icons and
Do Fefesh Fate SOz = programs may also be
4 dragged between the
mlrg:: I Full Sereen (No Border) displays.
=2 |
i Dekios ﬂ
— _ — Figure 3-9
ok | Device Settings

(Extended Desktop

You can also enable the Extended Desktop mode from the Display Properties Mode)
ode

control panel (see “Display Properties” on page 3 - 7).
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To Enable Extended Desktop (Display Properties)

/ A 1. Plug the monitor into the appropriate port.
2. Click Start, point to Settings (or just click Control Panel) and click Control
Extended Desktop Panel (if you are in Category View choose Appearance and Themes).
Mode 3. Double-click Display (icon).

If Intel Dual Display 4, In.the Display Pr_operties dialog box, click Settings (tab).
Clone mode is current- 5. Click the monitor icon (e.g. B), and make sure you have checked “Extend
ly enabled, you must my Windows desktop onto this monitor.” and click Apply.

Click the appropriate
monitor icon to be able to
select the option to extend
the desktop on to it.

use the Intel(R)
82852/82855 GM/
GME Graphics Con-
troller Properties to
switch the display.

ol Mersis o ko) B3S2/92055 GMUGNE Graphes Danbs

ok ity

Highes [ b

Figure 3 _ 10 |.- 1200 by T8 s [ 3 ;

S
) Mesw

Display Properties T
(Extended Desktop & (e o
Mode) Use the control panel to drag the monitors to match the physical arrangement

you wish to use. In the example shown in Figure 3 - 10 the primary monitor
is on the left; the secondary display is on the right. You can drag any icons
or windows across to either display desktop, which makes it possible to have
one program visible in one of the displays, and a different program visible in
the other display.

.|
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Power Management Features

To conserve power, especially when using the battery, your computer uses the

ACPI power management system. Power management conserves power by
controlling individual components of the computer (the monitor and hard disk

drive) or the whole system.

Advanced Configuration and Power Interface

The ACPI interface provides the computer with enhanced power saving tech-
niques and gives the operating system (OS) direct control over the power and
thermal states of devices and processors. For example, it enables the OS to set
devices into low-power states based on user settings and information from ap-
plications. ACPI is fully supported in Windows XP and Windows 2000.
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Advanced Controls

Enabling Power Options

Power Options are enabled through the control panel in your Windows sys-
tem (Power Options). With other operating systems you may have power
management available, so check your documentation.

Figure 3 - 11 # Control Panel |ZHEHZ‘

p Obti Fle Edt Wew Favortes Tods Help -
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4 v P = 6 T e

Internet Keyboard Modem Mouse Network
L windows Update Options Settings Connections

@) Help and Support E‘ E\h E \‘.é 9 @‘

Phene and \power Options fPrinters and  Regionaland  Scanersand  Scheduled  Sounds and
ruane amera

. a Tasks Audio Devices
.| Configure energy-saving settings For your compuker. ,
50 = 7 Bz vez @&

Speech System  Taskbar and  TouchPanel User Accounts .92 features  Wireless Link
Start Meru settings

.
&
%
@
S

Fonts @

e
G

You may conserve power through Power Schemes (individual components) or
throughout the whole system.

.|
3 - 18 Enabling Power Options



Advanced Controls

Power Schemes

You can set your computer to conserve power through individual components /

by means of Power Schemes. You can also adjust the settings for each Resuming Operation
schemg to set the monitor to turn off afte_r a spe_:cified time, and the computer's The system can re-
hard disk motor to turn off if the hard disk drive has not been accessed for a sume from Monitor or
specified period of time (if the system reads or writes data, the hard disk motor Hard Disk Standby by
will be turned back on). The schemes may also be set to set a specified time | Pressing a key on the
for the system to enter Standby or Hibernate modes (see “Conserving Power | <€YPoard:

(System)” on page 3 - 21).

Power Options Properties @g|
| Power Schemes | Alarms | Power Meter | Advanced | Hibemate
f Select the power scheme with the most appropriate settings for F | g u re 3 - 12
S5t
this computer. Note that changing the setfings below wil madify
the selected scheme
Power Schemes

Pawer schemes

| Partable/Laptop ¥

Home/Office Desk.

Presentation

lways On

Mirimal Power Management

M Battery

= T T 57 Rl e

| 1en computer is: Q@ ugged in S

Tunoffmonitor,  After15mins v | [AtterSmins v

Tunoff had disks: | Ater30mins | | After 5 mins ¥|

Systemstanchy [Alter20mins | |AterSmine |

System hibernales: | Alter3hous v (Ao Zhous v

. |
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Each Windows Power Scheme will also adjust the processor performance of
your machine in order to save power. This is worth bearing in mind if you are
experiencing any reduced performance (especially under DC/battery power).

Choose the Home/Office scheme for maximum performance when the com-
puter is powered from an AC power source. Choose the Max Battery scheme
(bear in mind that this scheme may slow down the overall performance of the
computer in order to save power) for maximum power saving when the com-
puter is battery (DC power) powered.

For advanced information see “Power Schemes & Processor Performance”
on page A - 2. This Appendix also contains information on the “Intel CPU
SpeedStep Controls™ (on page A - 3) which help you maximize the balance
between power saving and processor performance.

. |
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Conserving Power (System)

With this function you can stop the computer’s operation and restart where
you left off. This system features Standby and Hibernate sleep mode levels
(Hibernate mode will need to be enabled by clicking the option in the Hiber-

nate tab in the Power Options control panel - Figure 3 - 13 on page 3-22).

Hibernate Mode vs. Shutdown
Hibernate mode and Shutdown are the same in that the system is off and you
need to press the power button to turn it on. Their main difference is:

When you come back from hibernation, you can return to where you last left
off (what was on your desktop) without reopening the application(s) and
file(s) you last used.

You can use either method depending on your needs.

Standby Mode vs. Hibernate Mode

If you want to stay away from your work for just a while, you can put the sys-
tem on standby instead of in hibernation. It takes a longer time to wake up the
system from Hibernate mode than from Standby mode.

.|
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4

System Resume

The system can re-
sume from Standby
mode by:

* Pressing the power
button

* Pressing the key
combination Fn +
F4

» An alarm resume
that is enabled and
expires

* An incoming call
received on the
modem

Figure 3-13
Enable Hibernation

Standby

Standby saves the least amount of power, but takes the shortest time to return
to full operation. During Standby the hard disk is turned off, and the CPU is
made to idle at its slowest speed. All open applications are retained in memo-
ry. When you are not using your computer for a certain length of time, which
you specify in the operating system, it will enter Standby mode to save power.

Hibernate

Hibernate uses no power and saves all of your information on a part of the
HDD before it turns the system off. Although it saves the most power it takes
the longest time to return to full operation. You can set your computer to au-
tomatically enter Hibernate mode when the battery power is almost depleted.
You will need to enable Hibernate mode from the Hibernate tab in the Power
Options control panel. The system will resume from Hibernate mode by
pressing the power button.

Power Options Properties @@
Power Schemes | Alaims | Power Meter | Advanced | Hibemate

[ “when your computer hibemates, it stores whatever it has in
n memory on your hard disk and then shuts down. WWhen your
computer comes out of hibemation, it retums 1o its previous state:

Disk space for hibemation
Free disk space: 3359 MB
Disk space required to hibermate: 222 MB
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Configuring the Power Button

The power button may be set to send the computer in to either Standby or Hi-
bernate mode. In Standby mode, the LED (!) will flash green. In Hibernate
mode the LED will be Off (battery powered)/Orange (AC Adapter powered).

In a power saving mode set to save power through individual components (e.g.
hard disk, monitor), the LED will remain green.

Pawnr Optiors Prapartios
Powers Schennes | Alavins | Power Wit | Adveresd | Hienale

Poawes Sehers | Alsems | Powes Miser| Aibvorced | Hisste Fowwes Schernns | s | Poswer Hrte | Avenced | Hbemale,
"'_h Skt T power s sl you wied Bt 5y Selectthe poersmvmg setngs o e "1_% Sebect T power s sl you el B s
Biora Dt Bpiora
] tbweag shows ion on he baskbas ] b s i 2 ths nnck o ] tbweag shows ion on he baskbas

[=] Eromet by [] Promgs for paswond when comprist rsumes: bam sandby

e unzns Powes o e unzns

Shon | chesie the &d of my ponable compun: mlm‘mumww-&m ‘hen | chisee the i ol my gomable comgute
Stard by - Starsd by - Stard by -
Wher | pres e prmsst bufton or my compatiet m:;_ Whr | pres e prmret bt or e et
Shut dosey . Shet dovn ¥ Shut dosey 3
Eﬂ;«mmﬂo ‘When | pres the theep bufon on my compuber ‘when | press the sieep bution on my computer
_’” Stand by - Stard by 2
E;nld'\nlli\dﬂ
o
Power Button Lid Sleep/Resume (Sleep) Button

4

Sleep Button

You may also configure the Sleep/Resume key combination (Fn + F4) from the
menu illustrated in Figure 3 - 14. In Windows this is referred to as the Sleep button.

Conserving Power (System) 3 - 23
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2 &
Lid Button

It is recommended that
you set the lid (left
LCD cover sensor)
power button to “Do
nothing”.

This will prevent acci-
dentally triggering a
power saving mode
when you rotate the
LCD swivel screen.

Figure 3-14
Power Options
(Advanced - Power
Buttons)




Advanced Controls

v Battery Information

’Q\ Follow these simple guidelines to get the best use out of your battery.
Caution

New Battery

Always completely discharge, then fully charge, a new battery before using it
(see “Battery FAQ” on page 3 - 25 for instructions on how to do this).

Danger of explosion if
battery is incorrectly
replaced.

Replace only with the Battery Life
Sl R EVEICEE Y our computer’s battery life is dependent upon many factors, including the
LRSI hrograms you are running, and peripheral devices attached. Power Options
the manufacturer. Dis- .

(you may set low battery Alarms and actions, and check the Power Meter

card used battery ac- ) ' : g
cording to  the from the Power Options control panel), and settings in the OS will help pro-

manufacturer's in- long the battery life if configured appropriately.
structions.
| [E=—
. i i o
Figure 3-15 ] ple= @
. AT B Nk @Il-‘,‘
Power Options e biey o
(Alarm & Power w3 e
Meter) (] Movesen ot T
ﬂk:nm;m :::““ Lk, an invchas Sttony ion for e mdpenation.
CoJlo=] - (]

3 - 24 Battery Information



Battery life may be shortened through improper maintenance. To optimize the
life and improve its performance, fully discharge and recharge the battery at
least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to
remove the battery for any reason see “Removing the Battery” on page 6 - 3.

Battery FAQ

How do I completely discharge the battery?

Use the computer with battery power until it shuts down due to a low battery.
Don’t turn off the computer by yourself even when you see a message that in-
dicates the battery is critically low, just let the computer use up all of the bat-
tery power and shut down on its own (it is best to disable the Power Options
functions in the Control Panel). As the battery nears the end of its life save
and close any critical files.

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light
changes from orange to green.

How do | maintain the battery?
Completely discharge and charge the battery at least once every 30 days or af-
ter about 20 partial discharges.

Advanced Controls

4

Conserving Battery
Power

To conserve battery
power:

Lower the brightness
level of the LCD dis-
play.

Close modem or com-
munication  applica-
tions when they are not
being used.

Remove any unused
PC Cards from the
computer (PC Cards
quickly use up battery
power even if the sys-
tem enters sleep
mode).

Disconnect any unnec-
essary external devic-
es.

.|
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PC Camera

4

_ o If you have purchased the optional PC Camera you will need to install the de-
Taking Still Pictures vice driver for it as indicated in “PC Camera (Win2000)” on page 4 - 12 and
You may take still pic- “PC Camera (WinXP)” on page 4 - 19. The optional PC Camera driver is
tures in the Windows provided on its own CD, and is not on the Device Drivers & Utilities + User’s
XP operating system Manual CD-ROM.
only.
gg;bltf;ircli(co:\hﬁn chZ After installing the driver you can run the application software by going to the
deskt%p or go the CMM PC Camera item in the Start > Programs/All Programs menu and
Start menu and point selecting the AMCAP program. If you are using the Windows XP operating
to My Computer, then system you can double-click the CMM PC Camera icon in My Computer
click it. to take still pictures (see sidebar).
Double-click the CMM
PC Camera icon.

G

MG Camera Latest PC Camera Driver Information

Check the PC Camera CD, and any accompanying insert pages, for the latest up-
dated information on the PC Camera driver, which may override the information
provided here.

Click Take a new pic-
ture in the Camera
Tasks box.
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PC Camera Audio Setup

If you wish to capture video & audio with your camera, it is necessary to setup
the audio recording options in Windows.

(WinXP)

1.

Go to the Start menu and point to Settings (or just click Control Panel) and
click Control Panel, then double-click the Sounds & Audio Devices icon
(Category View > Speech, and Audio Devices).

2. Click Advanced in the Volume tab.

3. Click Options (Volume Control) and scroll down and click Properties.

4. Click Recording (Adjust volume for) and click Microphone (check box),
then click OK.

5. Make sure the Select (check box) in the Recording Control panel, under
the Microphone section, is checked (boost the volume as high as it will go).

6. Close the open windows.

(Win2000)

1. Go to the Start menu and point to Settings and click Control Panel then
double-click the Sounds and Multimedia icon.

2. Click Audio (tab) and click Volume (button) in the Sound Recording menu.

3. Select Advanced Controls from the Options menu.

4. Make sure the Select (check box) in the Microphone section is checked,
and boost the volume as high as it will go.

5. Close the windows.
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Figure 3- 16
Audio Setup
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Sounds and Audio Devices Properties
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AMCAP

AMCAP is a video viewer useful for general purpose video viewing and test-
ing, and capturing video files to .avi format.

1.

Run the AMCAP program from the Start > Programs/All Programs > CMM
PC Camera menu (it is recommended that you set the capture file before
the capture process - see Set Capture File below).

Go to the Capture menu heading (if you wish to capture audio make sure
that the Capture Audio option is ticked) and select Start Capture.

On the first run of the program (if you have not set the captured file) you will
be asked to choose a file name and size (see the sidebar - Pre-Allocating
File Space) for the captured file. Click Start Capture again.

Click OK to start capturing the video, and press Esc to stop the capture.

If you wish to, you may go to the File menu and select Save Captured
Video As..., choose a file name and location, then click Open (you can view
the file using the Windows Media Player).

Set Capture File

In AMCAP program you will only be asked to set the capture file name on the
first run of the program. When you run the program the next time the file will
automatically be overwritten with the newly captured file. To avoid overwrit-
ing files you can go to the Set Capture File.. option in the File menu, and set
the file name and location before capture. Set the name and location then click
Open (you can choose Cancel to ignore the file size if prompted).
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Pre-Allocating File
Space

You may pre-allocate
the file size for the cap-
ture file in the AMCAP
program. You can
choose to ignore this
by clicking Cancel.

Pre-allocating  space
on the hard disk can
improve the capture
quality (particularly of
large capture files), by
reducing the amount of
work the hard disk has
to do in finding space
for the video data as it
is being captured.

You may find it helpful
to defragment the HDD
before capture.
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Eliminating Screen Flicker
If you find that the video screen in the AMCAP program is flickering, you can
try to adjust the option from the Video Capture Filter options.

1. Runthe AMCAP program from the Start > Programs/All Programs > CMM

PC Camera menu.
2. Goto Options and scroll down to select “Video Capture Filter...”.
3. You can choose either 50Hz or 60Hz from the No Flicker box.

X
Figure 3-17
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Wireless LAN Module

The computer’s 802.11b Wireless LAN module, and its antenna and other
components, are not externally visible (please check with your service repre-
sentative). Make sure you install the driver (see pages 4 - 11 & 4 - 17). The
802.11b Wireless LAN module driver is provided on its own CD, and is not
on the Device Drivers & Utilities + User’s Manual CD-ROM. You will also
find instructions on pages 4 - 12 & 4 - 18 for accessing the User Guides.
Make sure the wireless module is OFF when you are using the computer
aboard aircraft (see sidebar note).

You can configure the wireless network settings from the full instructions pro-
vided in the User Guides. Some general Windows networking control panels
are illustrated overleaf. These control panels can be accessed by clicking the
Start (menu), browsing to Settings, and clicking Network Connections/Net-
work and Dial-Up Connections (or Connect To > Show all connections in
WinXP default Start menu configuration).

Advanced Controls

A

Wireless Device
Operation Aboard
Aircraft

The use of any porta-
ble electronic trans-
mission devices
aboard aircraft is usu-
ally prohibited.

Make sure the module
is OFF if you are using

the computer aboard
aircraft.

When your computer
‘Boots Up’ the module
will be ON.

To toggle power to the
WLAN module use the
key combination Fn +
F11, or the

Wireless LAN Module 3 - 31
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Figure 3-18
Network Control
Panels
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Drivers & Utilities

Chapter 4: Drivers & Utilities

Overview

This chapter deals with installing the drivers and
utilities essential to the operation or improvement
of some of the computer’s subsystems. The system
takes advantage of some newer hardware compo-
nents for which the latest versions of most available
operating systems haven’t built in drivers and utili-
ties. Thus, some of the system components won’t
be auto-configured with an appropriate driver or
utility during operating system installation. Instead,
you need to manually install some system-required
drivers and utilities. In this chapter, we group driver
and utility installation instructions by operating
system. The following operating systems are cov-
ered.

» Windows 2000 (with Service Pack 4 included)
* Windows XP Professional & Home Editions

g

Assumption

We assume that you will install all drivers and utilities
from the built-in CD device and it is assigned to “Drive
D:”. In addition, all file extensions can be seen [see
“Navigate (Browse..) to D:” on page 4 - 4].

Overview 4 - 1
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What to Install

The Device Drivers & Utilities + User’s Manual
CD-ROM contains the drivers and utilities neces-
sary for the proper operation of the computer. (The
drivers for the Wireless LAN and optional PC
Camera modules and are on the separate CDs pro-
vided.) Table 4 - 1 on page 4-7 lists what you need
to install manually according to your choice of the
operating system. It is very important that the
drivers are installed in the order indicated in the
table.

Windows XP & 2000 Service Packs
Check the warnings on this page regarding installa-
tion of the appropriate Service Pack for your Win-
dows XP OS (if you are unsure of the Service Pack
currently installed see “Service Pack Installed”” on
page 4 - 3). Make sure you have installed the appro-
priate Service Pack before installing all the drivers
if you are using Windows XP. Make sure that your
Windows 2000 version includes Service Pack 4 on
the installation CD.

N
/ﬂ\
Windows XP Service Pack 1/1a

Make sure you install Windows XP Service Pack 1/
la (or a Windows XP version which includes Service
Pack 1/1a) before installing any drivers. Service
Packs 1 and 1a include support for USB 2.0.

If you have upgraded the system by installing Ser-
vice Pack 1/1a (i.e. your Windows XP version does
not include Service Pack 1/1a) then follow these in-
structions:

1.Go to Device Manager (see step 1 of the Touch

Panel driver installation instructions on page
) and click “+” next to Other devices (if its sub-

items are not shown).

2.Right-click Universal Serial Bus (USB) Control-
ler and select Uninstall > OK.

3.Restart the computer and it will find the USB 2.0
controller.

4 - 2 What to Install



2 &
Windows 2000 with Service Pack 4

Make sure that your Windows 2000 version in-
cludes Service Pack 4 on the installation CD.

S

Windows 2000 (SP4) Internet Explorer 5.5 &
DirectX 8.1

Make sure that you install Internet Explorer 5.5 (or
higher version) if you are using the Windows 2000
(with Service Pack 4 installed) OS.

Make sure that you go to the Microsoft website to
download and install DirectX 8.1 (or higher version)
if you are using the Windows 2000 (SP4) OS.

Drivers & Utilities

4

Service Pack Installed

To see which Service Pack is currently installed on
your computer go to the General tab of the System
control panel. Right-click the My Computer icon on
the desktop or in the Start menu (in WinXP only) and
select Properties. The Service Pack currently in-
stalled on your system will be listed under the “Sys-
tem:” heading. (If no Service Pack information is
listed, then no Service Pack is installed.)

What to Install 4 - 3
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New Hardware Found

If you see the message “New Hardware Found”
(Found New Hardware Wizard) during the
installation procedure (other than when outlined in
the driver install procedure), click Cancel to close
the window, and follow the installation procedure
as directed.

4 - 4 What to Install

4

Navigate (Browse..) to D:

You will notice that many of the instructions for driver
installation require you to “Navigate (Browse) to D:".

In this case “D:” is the drive specified for your CD de-
vice. Not all computers are setup the same way, and
some computers have the CD listed under a different
drive letter - e.g. if you have two hard drives (or hard
disk partitions) one may be designated as “Drive C:”
and the other as “Drive D:”. In this case the CD device
may be designated as “Drive E:” - Please make sure
you are actually navigating to the correct drive letter
for the CD device.

When you click the Browse (button) after clicking
Run in the Start menu you will see the “Look in:” di-
alog box at the top of the Browse window. Click the
scroll button to navigate to My Computer to display
the devices and drive letters.



Authorized Driver Message

If you receive a message telling you that the driver
you are installing is not authorized (Digital Signa-
ture Not Found), just click Yes or Continue Any-
way to ignore the message and continue the
installation procedure.

You will receive this message in cases where the
driver has been released after the version of Win-
dows you are currently using. All the drivers pro-
vided will have already received certification for
Windows.

Version Conflict Message

During driver installation if you encounter any “file
version conflict” message, please click Yes to
choose to keep the existing (newer) version.

Drivers & Utilities

Updating/Reinstalling Individual

Drivers

If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To
do this go to the Control Panel in the Windows OS
and double-click the Add/Remove Programs
item. If you see the individual driver listed (if not
see below), uninstall it, following the on screen
prompts (it may be necessary to restart the comput-
er). Go to the appropriate section of the manual to
complete the update/reinstall procedure for the
driver in question.

If the driver is not listed in the Add/Remove Pro-
grams item:

1. Click Start (menu), point to Settings and click
Control Panel. Double-click System (icon)
and then click Hardware (tab) > Device Man-
ager (button).

2. Double-click the device you wish to update/
reinstall the driver for (you may need to click
“+11).

3. Look for the Update Driver button (check the
Driver tab) and follow the on screen prompts.

What to Install 4 - 5
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Driver Installation

You have a choice of installation methods to install
your drivers.

Automatic Driver Installation

Insert the Device Drivers & Utilities + User’s Man-
ual CD-ROM and the Drivers Installer applica-
tion will run automatically.

==

@ Driver ler .

" Install Chipset driver

. Install Audio driver
Install ¥GA driver
Install LAN driver
" Install Modem driver
Install ENE-PCMCIA driver
Install Touch Pad driver
Install ¥GA-Rotate-AP
Install Touch Panel driver
Install Acrobat Reader 5.0
Read User Manual [.pdf]

This CD is for
notebook drivers
installation.

Exit

Figure 4 - 1 - Drivers Installer

1. Check the driver installation order from the table
Table on page 4-7 (the drivers must be
installed in this order).

2. Click the driver you wish to install, and click Yes
to continue (do not press any keys).

3. Follow the installation procedure as listed in the
manual installation process (the automatic
installation procedure eliminates the need to
navigate to the setup executable file).

4. If the computer needs to restart after installing a
driver, you can return to the Drivers Installer
screen by either:

Clicking Start (menu) > Run... and navigating
(Browse..) to D:\DriverInstaller.exe and
clicking OK.

OR

Ejecting and re-inserting the CD.

OR

Double-clicking the My Computer icon, and
then double-clicking CD icon (WinXP only).

Note: The drivers for the Wireless LAN and op-
tional PC Camera modules and are on the separate
CDs provided. The Touch Panel driver (for Model
A computers only) must be installed manually.

. |
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Manual Driver Installation

Insert the Device Drivers & Utilities + User’s Man-
ual CD-ROM and close the Drivers Installer ap-
plication. Follow the procedures listed in this
chapter (the drivers for the Wireless LAN and op-
tional PC Camera modules and are on the separate
CDs provided).

4

*Service Pack Installed

To see which Service Pack is currently installed on
your computer go to the General tab of the System
control panel. Right-click the My Computer icon on
the desktop or in the Start menu (in WinXP only) and
select Properties. The Service Pack currently in-
stalled on your system will be listed under the “Sys-
tem:” heading. (If no Service Pack information is
listed, then no Service Pack is installed.)

Table 4 - 1 - Install Order

. |
Driver Installation 4 - 7

Drivers & Utilities

Driver Win 2000 (SP4) Win XP
Make sure Ser- | Install Win-
vice Pack 4 is dows

Service Pack included on the Service Pack
installation CD 1/1aif not
included*

Chipset page 4 -8 page 4 - 14

Audio page 4 -9 page 4 - 14
Video (VGA) page 4 -9 page 4 - 15
LAN page4-9 page 4 -15
Modem page 4 -9 page 4 - 15
ENE-PCMCIA page 4 - 10 page 4 - 16
TouchPad page 4 - 10 page 4 - 16
Wireless LAN page 4 - 11 page 4 - 17
PC Camera page 4 - 12 page 4 - 19
Screen Rotation page 4 - 13 page 4 - 19
Touch Panel page 4 - 13 page 4 - 20

(Model A only)
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Windows 2000 Chipset (Win2000)

. . . e . 1. Click Start (menu) > Run...
This section covers driver and utility installation in 2. Navigate (Browse..) to

structions for the Windows 2000 (SP4 installed). D:\Drivers\inf_update\infinst_autol.exe and
click OK.
7&( 3. Click Next > Yes > Next.

4. Click Finish to restart the computer.

G
Windows 2000 (SP4) Internet Explorer 5.5 &
DirectX 8.1

Windows 2000 with Service Pack 4

Make sure that your Windows 2000 version in-

cludes Service Pack 4 on the installation CD.

Make sure that you install Internet Explorer 5.5 (or

higher version) if you are using the Windows 2000
(with Service Pack 4 installed) OS.

Make sure that you go to the Microsoft website to
download and install DirectX 8.1 (or higher version)
if you are using the Windows 2000 (SP4) OS.

. |
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Audio (Win2000)

1. Click Start (menu) > Run...

2. Navigate (Browse..) to
D:\Drivers\Audio\Setup.exe and click OK.

3. Click Next.

4. Click Finish to restart the computer.

5. You can click the AC97 Audio Configuration

icon @ in the taskbar for configuration options.

Video (Win2000)

1. Click Start (menu) > Run...

2. Navigate (Browse..) to
D:\Drivers\VGA\Setup.exe and click OK.

3. Click Next > Yes (click Continue Anyway if
asked if you want to continue).

4. Click Finish to restart the computer.

5. See “Video Driver Controls” on page 3 - 6 for
details on adjusting the video settings.

Drivers & Utilities

LAN (Win2000)

. Click Start (menu) > Run...

Navigate (Browse..) to
D:\Drivers\Lan\Setup.exe and click OK.
Click Next.

Click Finish.

The network settings can now be configured.

Modem (Win2000)

1.
2.

Click Start (menu) > Run...

Navigate (Browse..) to
D:\Drivers\Modem\Win2K\Setup.exe and
click OK.

. Click [Z==_1 (button).
. Click [«
. The modem is ready for dial-up configuration.

4

Modem Country Selection

Be sure to check if the modem country selection is ap-
propriate for you (Control Panel > Phone and Mo-
dem Options).

Windows 2000 4 - 9
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ENE-PCMCIA (Win2000)

This driver is also required by the 4-in-1 Card

Reader.

1. Click Start (menu) > Run...

2. Navigate (Browse..) to D:\Drivers\ENE-
PCMCIA\Setup.exe and click OK.

3. Click Next > Next.

4. Click Finish to restart the computer.

4 - 10 Windows 2000

TouchPad (Win2000)

1.
2.

3.

Click Start (menu) > Run...

Navigate (Browse...) to D:\Drivers\Touch
Pad\Setup.exe and click OK.

To continue click Next > Next > Next (click
Yes if asked if you want to continue).

Click Finish to restart the computer.

You may then configure your TouchPad as
outlined in “TouchPad and Buttons/Mouse”
on page 2 - 25.



Wireless LAN (Win2000)

Make sure the module is powered on before install-
ing the driver. To toggle power to the WLAN mod-
ule use the key combination Fn + F11, or “VGA
Rotate Application” on page 3 - 4.

1.

g own

1S

Insert the Intel PRO CD-ROM into the CD
drive.

Click Wireless LAN Adapters (button).
Click Install Software (button).

Click Next.

Click the button to accept the license and click
Next > Next > Install > Finish.

Click Start (menu), point to Settings and click
Control Panel. Double-click System (icon)
and then click Hardware (tab) > Device
Manager (button).

Click Device Manager (tab), then click “+”
next to Other Devices (if its sub-items are not
shown).

Double-click Network Controller, and click
the Reinstall Driver (button).

When the Upgrade Device Driver Wizard
appears, click Next (make sure that you have

Drivers & Utilities

selected “Search for a suitable driver for my
device (recommended)”) and click Next.

10.When Locate Driver Files appears, select

ONLY *“Specify a location” and click Next.

11.Navigate (Browse...) to

D:\PROW7100\WIN2K.

12.Click Open > OK > Next.
13.Click Finish and close the open windows.

You can now install the Administration Tools.

o gakrwnh =

Insert the Intel PRO CD-ROM into the CD
drive.

Click Wireless LAN Adapters (button).
Click Install Administration Tools (button).
Click Next.

Click the button to accept the license and click
Next > Next > Install > Finish.

You can configure the settings by going to the
Start menu and pointing to Programs and
clicking Intel Network Adapters, then click-
ing either the Intel (R) PROset icon, or the
options under the Access Point Administra-
tion Tools.

Windows 2000 4 - 11
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You can view the User Guides by inserting the Intel
PRO CD-ROM and clicking Wireless LAN
Adapters (button) > View User Guides (button).

- Intel@ PRO Network Connections

intel’ PRO Network
Connections

Intel PRO/Mireless LAN Adapters

Figure 4 -2
View User Guides

4 - 12 Windows 2000

PC Camera (Win2000)

1. Insert the PC Camera CD-ROM into the
drive.

2. The program will run automatically.

3. Click Next (click Yes if asked if you want to
continue at any time).

4. Click Finish and restart the computer.

5. After restart the computer will find the new
hardware for you (click Yes if asked if you want
to continue at any time).

6. To run the application software go to the CMM
PC Camera item in the Start > Programs
menu and select the AMCAP program (see
“PC Camera” on page 3 - 26).

2 &

Latest PC Camera Driver Information

Check the PC Camera CD, and any accompanying
insert pages, for the latest updated information on
the PC Camera driver, which may override the infor-
mation provided here.




Screen Rotation (Win2000)

1. Click Start (menu) > Run...

2. Navigate (Browse...) to D:\Drivers\VGA-
Rotate-AP\SETUP.EXE and click OK.

3. Click Next.

4. Click Finish to restart the computer.

Touch Panel (Win2000)

Only Model A computers support touch panel fea-
tures. If your computer is Model B it is not neces-
sary to install the driver.

1. Click Start (menu), point to Settings and click
Control Panel. Double-click System (icon)
and then click Hardware (tab) > Device Man-
ager (button).

2. Click Device Manager (tab), then click “+”
next to Mice and other pointing devices (if its
sub-items are not shown).

3. Double-click Microsoft Serial Mouse, and
click the Driver (tab).

4. Click Update Driver (button).

5. When the Upgrade Device Driver Wizard
appears click Next.

6.

8.
9.

Drivers & Utilities

Select “Display a list of the known drivers
for this device so that I can choose a specific
driver” and click Next.

. Click Have Disk (button) and navigate

(Browse...) to D:\Drivers\Touch Panel and
click Open > OK > Next (click Yes if asked if
you want to continue).

Click Next (click Yes if asked if you want to
continue).

Click Finish and close the open windows.

10.See*““Touch Panel (Model A Only)” on page 2 -

19.
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Windows XP

This section covers driver and utility installation in-

structions for the Windows XP OS.

S
Windows XP Service Pack 1/1a

Make sure you install Windows XP Service Pack 1/
1la (or a Windows XP version which includes Service
Pack 1/1a) before installing any drivers. Service
Packs 1 and 1a include support for USB 2.0.

If you have upgraded the system by installing Ser-
vice Pack 1/1a (i.e. your Windows XP version does
not include Service Pack 1/1a) then follow these in-
structions:

1.Go to Device Manager (see step 1 of the Touch

Panel driver installation instructions on page
) and click “+” next to Other devices (if its sub-

items are not shown).

2.Right-click Universal Serial Bus (USB) Control-
ler and select Uninstall > OK.

3.Restart the computer and it will find the USB 2.0
controller.

Chipset (WinXP)
1. Click Start (menu) > Run...

N

. Navigate (Browse..) to

D:\Drivers\inf_update\infinst_autol.exe and
click OK.

Click Next > Yes > Next.

Click Finish to restart the computer.

Audio (WinXP)

Click Start (menu) > Run...

Navigate (Browse..) to
D:\Drivers\Audio\Setup.exe and click OK.
Click Next.

Click Finish to restart the computer.

You can click the AC97 Audio Configuration
icon @ in the taskbar for configuration options.

4 - 14 Windows XP
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Video (WinXP) Modem (WinXP)
1. Click Start (menu) > Run... 1. Click Start (menu) > Run...
2. Navigate (Browse..) to 2. Navigate (Browse..) to
D:\Drivers\VGA\Setup.exe and click OK. D:\Drivers\Modem\WinXP\Setup.exe and
3. Click Next > Yes. click OK.
4. Click Finish to restart the computer. 3. Click [==_1 (button).
5. See “Video Driver Controls” on page 3-6 for 4. Click v _1.
details on adjusting the video settings. 5. The modem is ready for dial-up configuration.
LAN (WinXP) Ve

1. Click Start (menu) > Run...

2. Navigate (Browse..) to

3 gl.i\g(rp{;:s\Lan\Setup.exe and click OK. Be sure to check if the modem country selection is ap-
) . o propriate for you (Control Panel > Phone and Mo-

4. Click Finish. dem Options).

5. The network settings can now be configured.

Modem Country Selection

|
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ENE-PCMCIA (WinXP) TouchPad (WinXP)

This driver is also required by the 4-in-1 Card 1. Click Start (menu) > Run...

Reader. 2. Navigate (Browse...) to D:\Drivers\Touch

1. Click Start (menu) > Run... Pad\Setup.exe and click OK. _

2. Navigate (Browse”) to D:\Drivers\ENE- 3. To CO_ntInue click NeXt > NeXt > Next (CIle
PCMCIA\Setup.exe and click OK. Continue Anyway if asked if you want to

3. Click Next > Next. continue).
4. Click Finish to restart the computer. Click Finish to restart the computer.
You may then configure your TouchPad as

outlined in “TouchPad and Buttons/Mouse”
on page 2 - 25.

ok

. |
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Wireless LAN (WinXP) 8. Click the Hardware (tab), then click Device
Make sure the module is powered on before install- Mgna‘g‘;e’r’ (button). ) o
ing the driver. To toggle power to the WLAN mod- 9 Click *+” next to Other Devices (if its sub-

oo “ items are not shown).
l;lst;tsee;\};f)|:<(:e£;/tigcr)\Tt())lr?a[;[{:1c;]2 3Fn: F11, or "VGA 10.Double-click Network Controller and click

Reinstall Driver (button).

1. Insert the Intel PRO CD-ROM intothe CD 11 When the Hardware Update Wizard appears,
drive. click “Install from a list or specific location

2. Click Wireless LAN Adapters (button). (Advagced) then click Next. . ;

3. Click Install Software (button). 12.Select “Search for the best driver in these

4 Click Next. locations.” and select ONLY “Include this

5. Click the button to accept the license and click location in the search:*.

13.Navigate (Browse...) to
D:\PROW7100\WINXP and click OK > Next.
14.Click Finish and close the open windows.

Next > Next > Install > Finish.
If you can see the My Computer icon on your
desktop (if you cannot see the My Computer
icon go to step 7) click on it once to select it, ) . )
then right-click it to make the sub-menu appear You can now install the Administration Tools (see
and scroll down to Properties and click on it over).
(go to step 8).
7. If you cannot see the My Computer icon click

Start (menu), then point to (but don’t click just

highlight it) My Computer. Right-click it to

make the sub-menu appear and scroll down to

Properties and click on it (go to step 3).

Sk
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1. Insert the Intel PRO CD-ROM into the CD
drive. Intel® PRO Network Connections
2. Click Wireless LAN Adapters (button). .
3. Click Install Administration Tools (button). bl i
4. Click Next. . Intel PROMVireless LAN Adapters
5. Click the button to accept the license and click
Next > Next > Install > Finish. T
6. You can configure the settings by going to the

Start menu and pointing to Programs/All
Programs and clicking Intel Network
Adapters, then clicking either the Intel (R)
PROset icon, or the options under the Access
Point Administration Tools.

You can view the User Guides by inserting the Intel

PRO CD-ROM and clicking Wireless LAN

Adapters (button) > View User Guides (button). Figure 4 - 3
View User Guides
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PC Camera (WinXP)
1. Insert the PC Camera CD-ROM into the

drive. 2 &

2. The program will run automatically.
3. Click Next (click Continue Anyway if asked if Latest PC Camera Driver Information
you Wa'_]t _'[0 continue at any time). Check the PC Camera CD, and any accompanying
4. Click Finish to restart the computer. insert pages, for the latest updated information on
5. When the Found New Hardware Wizard the PC Camera driver, which may override the infor-
appears select “Install the software mation provided here.
automatically (Recommended)” then click
Next.
6. Click Finish and restart the computer (click Yes
to do so automatically when the dialog box Screen Rotation (WinXP)
appears).

1. Click Start (menu) > Run...

7. To run the application software go to the CMM 2. Navigate (Browse...) to DADrivers\WGA-

PC Camera item in the Start > Programs/All :
Programs menu, and select the AMCAP Rotate-AP\SETUP.EXE and click OK.

program. . Click Next.

3
8. Double-click the CMM PC Camera icon in 4. Click Finish to restart the computer.
My Computer to take still pictures (see “PC
Camera” on page 3 - 26).
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Touch Panel (WinXP)

Only Model A computers support touch panel fea-
tures. If your computer is Model B it is not neces-

sary to install the driver.

1.

If you can see the My Computer icon on your
desktop (if you cannot see the My Computer
icon go to step 2) click on it once to select it,
then right-click it to make the sub-menu appear
and scroll down to Properties and click on it
(go to step 3).

If you cannot see the My Computer icon click
Start (menu), then point to (but don’t click just
highlight it) My Computer. Right-click it to
make the sub-menu appear and scroll down to
Properties and click on it (go to step 3).

Click the Hardware (tab), then click Device
Manager (button).

Click “+” next to Mice and other pointing
devices (if its sub-items are not shown).
Double-click Microsoft Serial Mouse and
click Driver (tab).

Click Update Driver (button).

4 - 20 Windows XP
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. When the Hardware Update Wizard appears,

click “Install from a list or specific location
(Advanced)” then click Next.

Select “Don’t search. I will choose the driver
to install.” and click Next.

Click Have Disk (button) and navigate
(Browse...) to D:\Drivers\Touch Panel and
click Open > OK > Next (click Yes and/or
Continue Anyway if asked if you want to
continue).

10.Click Finish and close the open windows.
11.See*“Touch Panel (Model A Only)” on page 2 -

19.
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Chapter 5: BIOS Utilities ¢

OverVieW Settings Warning

This chapter is about the computer’s built-in software. Incorrect settings can
i . . cause your system to
Your computer comes with built-in BIOS (Basic Input Output System) malfunction. To correct
which is an essential set of software routines stored on a chip in your comput- mistakes return to the
er. These routines serve to describe your computer’s hardware to your chosen [ el SR Sl
i d ides an interface between the two. The BIOS in- MENK and’ Seiect e
operating system, and provi : | _ Default Seftings and
cludes the POST (Power On Self Test) and the SCU (System Configuration click OK.
Utility). The POST performs diagnostic procedures at startup, the SCU al-

lows you to configure your computer.

There is one general rule: Don’t make any changes unless you are sure of
what you are doing. Many of the settings are required by the system, and
changing them could cause it to become unstable or worse. If you have any
doubts, consult your service representative.

If your computer has never been set up, or you are making important changes
to the system, then you should review this chapter first and note the original
settings found in the SCU. Even if you are a beginner, keep a record of the
settings you find and any changes you make. This information could be useful
if your system ever needs servicing.

. |
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The Power-On Self Test (POST)

Each time you turn on the computer, the system takes a few seconds to con-

4

The POST Screen ducta POST, including a quick test of the on-board RAM. As the POST pro-
1. BIOS information ceeds, the computer will tell you if there is anything wrong. If there is a
2. CPU type problem which prevents the system from booting, it will display a system
3. Memory status summary and prompt you to run SCU. If you do not see the POST screen see
4. Enter SCU prompt

: the sidebar for information on the Fast Boot and Display OEM logo options.
appears only during

POST If there are no problems, the SCU (System Configuration Utility) prompt

Note: The POST screen will disappear and the system will load the operating system. Once that starts,

pictured is for guideline you can’t get into the SCU without rebooting the computer.
purposes only. The

POST screen on your

computer may appear Insyde Software MobilePRO BIOS Version 1.010
Sllghtly different. Copyright 1983 - 2002 Insyde Software Corp. All Rights Reserved
If you choose the Fast
Boot option you will see HE VERSION 05.01.08 9
an abbreviated version 14001z Pentiium M with MMX CPU

. CPU Microcode Updatie Rew 005h Complete
of this screen. L2 Cache: 1024K inatalled

. 8MB Video RAM

If you choose the Dis- Insyde Sz?tware Plug-n-Play BIOS Ven 1.17.01
play OEM logo the- Base Memory 0000640 KB
screen will not appear me R O
(See page 5 - 4) Shared Memory 008192 KB

Figure 5 - 1 Auto Detecting IDE Devices [Done]

<F2> tio Enter System Confiiguvation Htilﬂ:ye

POST Screen

5 - 2 The Power-On Self Test (POST)
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and
“non-fatal”.

Fatal Errors

These stop the boot process and usually indicate there is something seriously
wrong with your system. Take the computer to your service representative or
authorized service center as soon as possible.

Non-Fatal Errors

This kind of error still allows you to boot. You will get a message identifying
the problem (make a note of this message!) followed by the prompt:

* Press <F1> to resume
» <F2>to enter System Configuration Utility

Press F1 to see if the boot process can continue. It may work, without the cor-
rect configuration.

Press F2 to run the SCU program and try to correct the problem. If you still
get an error message after you change the setting, or if the “cure” seems even
worse, call for help.

.|
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4

BIOS Settings V's OS
Settings

Though many options
such as power man-
agement and display
settings may be set in
the BIOS, these are
usually best set in your
OS (e.g. Windows).

Older OS’s such as
DOS etc. may still rely
entirely on the setup
information from the
BIOS.  “Plug-n-Play”
OS'’s, such as the vari-
ous Windows sys-
tems, may override
these settings with the
settings from the sys-
tem’s Control Panel.

The System Configuration Utility

The SCU program tells the system how to configure itself and manage basic
features and subsystems (e.g. port configuration and power management). The
settings are stored in a nonvolatile battery and written to the CMOS RAM.
This means that the settings are saved even when the computer is turned off.

Entering Setup

To enter the SCU, turn on the computer and press F2 when you see the prompt
“<F2> to enter System Configuration Utility”. The prompt seen in Figure 5 -
1 is usually present for a few seconds after you turn on the system. If you get
a “Keyboard Error” just press F2 again.

If the computer is already on, reboot and then hold down F2 when you see the
prompt. The SCU’s main menu will appear.

Entering Setup with Display OEM Logo Enabled

To enter the SCU with the Display OEM Logo enabled (see “Display OEM
logo (Startup Menu)” on page 5 - 10) you will need to press F2 when you see
the message “Press the <F2 Key> to enter the System Configuration Util-
ity” appear on the screen.

5 - 4 The System Configuration Utility
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Working with the Menu Bar

You can use the mouse to navigate around the various menus and submenus
of the SCU, or alternatively, you can use the following key combinations:

Keys Action Table5-1
SCU Menu

Navigation Keys

Alt Activates the menu bar

Left arrow/Right arrow — <«

2 Selects an option in the menu bar
Type the highlighted letters

Left mouse button

Down arrow Opens the pull-down menu bar
Spacebar options
Enter

Right mouse button

Cancels the action
Esc

Working with the Menu Bar 5 - 5
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Working with the Pull-Down Menu

Once your desired menu bar item is highlighted, press Enter or left-click with
the mouse to see the pull-down menu items. The following keys allow you to
Table 5 - 2 move about the pull-down menu:

Pull-Down Menu

Keys Keys Action

Down/Up arrows (3 T) Changes the value

Allows you to choose:
Enter <OK> to save changes
<Cancel to ignore any changes>

5 - 6 Working with the Pull-Down Menu
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Working with Sub-Menus

Some pull-down menu options have an arrow to the right of the entry which /
indicates a sub-menu is available. Choose these sub-menus by pressing Enter SCU Screens
and the screen will be displayed. Navigate through these screens by using the

keys in the table below: The screens which ap-

pear on the following
pages are intended as

. a guideline.
Keys Action
- It should be noted that
Tab Moves from one field to another the screen on your par-
] . ) ticular computer may
Down/Up arrows (J/T) Selects an item within the field appear a little different-
Enables the specified function (a dot indicates the .
Spacebar N
function is enabled)
OK/Enter Accepts the entglsjeasntcri] glg;gz tI;i sub-menu and
g Table 5 - 3
Cancel/Esc Rejects the entries and closes the sub-menu Sub Menus
(Right Arrow

Enabled)

Working with Sub-Menus 5 - 7
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Startup Menu

Insyde Software SCU For Intel chipset Aug 27, 2003 9:40:02 am
Memory Disks Components Power Exit

[ |
Date and Time D> |l — System

Figure 5 - 2 \ Fast Boot

Boot Device >
Startup Menu Display S CPU Clock = 1400MHz

\ Enable Battery Low Beep
Enable Power On Beep

\ Display OEM logo

\ Fast Boot for Windows XP

Boot Password > — Memory
SCU Password >
L Base = 640 KB

Extended = 252928 KB
Shadow = 64 KB
Reserved = 320 KB
Total RAM = 253952 KB
Cache (Ext) = 1024 KB

Set system date and time

Fast Boot (Startup Menu)
Enable this option to eliminate the memory test and other delays at power-up.
It is enabled by default.

5 - 8 Startup Menu
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Boot Device (Startup Menu)

Specify which device your computer should look on for an operating system
by priority. The default setting for the first boot device is Diskette A (external
floppy disk), the second boot device is Hard Disk C (internal hard disk), the
third boot device is the CD-ROM Drive (external CD device) and the fourth
boot device is PXE LAN (network boot). You may also set the computer to
boot from the USB HDD (external USB hard disk ). If the computer fails to
find an operating system on the first device in the priority list it will then move
on to look on the second device etc.

Display (Startup Menu)

Enables your choice of CRT (external monitor), LCD (the computer’s display
screen), or both. These settings are best changed in your OS (see “Display De-
vices” on page 3 - 11), and may also be quickly adjusted by means of the Fn
and F7 key combination (see “The Keyboard” on page 2 - 17). However if
you want to use multiple display devices in OS’s other than Windows, you
may set the options here.

Enable Battery Low Beep (Startup Menu)
Enable or disable the low battery beep if the power is getting low. It is enabled
by default.

Startup Menu 5 - 9
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ZRS
Password Warning

If you choose to set a
boot password, NEV-
ER forget your pass-
word.

The consequences of
this could be serious. If
you cannot remember
your boot password
you must contact your
vendor and you may
lose all of the informa-
tion on your hard disk.

Enable Power On Beep (Startup Menu)
Enable or disable (disabled by default) the beep when the computer “boots

up”.

Display OEM logo (Startup Menu)
Enable or disable (enabled by default) the display of the OEM logo (if appli-
cable) during the POST process.

Fast Boot for Windows XP (Startup Menu)
Enable or disable (enabled by default) the fast system startup option if you are
using the Windows XP OS.

Boot and SCU Passwords (Startup Menu)

You can set the passwords for when the computer starts-up (Boot Password),
and for access to the SCU to make changes (SCU password). See the sidebar
for a warning on setting the password.

.|
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Memory Menu

Insyde Software SCU For Intel chipset Aug 29, 2003 6:40:02 a

startup [N ;o Components Power Exit Figure 5 -3
bevi Memory Menu
—pevt
Hard ... R

VGA Shared Memory 1400MH=

VGA Shared Memory Size
) 8sMB
( ) 1eMB
(-) 32MB

640 KB
252928 KB
64 KB
320 KB
253952 KB
1024 KB

3
%

Press (Tab) key to select a control. <OK> button or <Enter> key accept
entries. <Cancel> button or <Esc> key reject entries. Use cursor, spacebar,
and numeric keys to change values. <Alt> key activates accelerators.

VGA Shared Memory (Memory Menu)

This is the pre-allocated memory size for VGA compatibility. This is fixed
at 32MB by default, and can be adjusted to 16MB or 8MB. This memory
is allocated from your system memory e.g. if you computer has 256 MB of
memory (RAM), then 32MB will be allocated to video leaving the system
with 224MB of RAM.

Memory Menu 5 - 11
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Figure5-4
Disks Menu
(IDE Settings)

Disks Menu

Insyde Software SCU For Intel chipset
| |

IDE Settings P

_ Virus Alert
IDE Settings

[X] Drive Enabled
[X] Multiple Sector Mode
[X] PIO Mode

Aug 27, 2003 6:40:02 amw

Primary ATAPI

[ 1 Drive Enabled
[X] PIO Mode

IDE UDMA-33/66/100 Function : Enable
IDE 32Bit I/O : Enable

)

Press (Tab) key to select a control. <OK> button or <Enter> key accept
entries. <Cancel> button or <Escs> key reject entries. Use cursor, spacebar,
<Alt> key activates accelerators.

and numeric keys to change values.

IDE Settings (Disks Menu)
You can use this menu to set the options for your hard disk and CD device.
Only make changes if you are sure of what you are doing.

Virus Alerts (Disks Menu)

Enable this option to receive a warning if the area of the hard disk containing
information on how to start up the computer is having information written to
it. This can help warn you if viruses are attempting to affect this area. This is
not a substitute for proper virus protection supplied by updated anti-virus soft-
ware, merely an extra safeguard (see “Viruses” on page 7 - 4).

I
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Insyde Software SCU For Intel chipset Aug 29, 2003 6:40:02

Startup Memory Disks Power Exit

— Devices

Hard Drive C

Press
entri
and n

COM Ports

System

_ Keyboard Numlo
Keyboard Repeaty

CPU Clock 1400MHz

Normal (16550)
IrDA (HPSIR)

640 KB
252928 KB
64 KB
320 KB
253952 KB
1024 KB

inter> key accept

BIOS Utilities

Figure5-5
Components Menu

am

Use cursor, spacebar,

*s accelerators.

COM Ports (Components Menu)
You can change the COM port settings from this menu. COM port A is the
Touch Panel port, and COM port B is the infrared port.

Components Menu 5 - 13
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Keyboard Numlock (Components Menu)
Enable this mode to start the computer up with Number Lock enabled.

Keyboard Repeat (Components Menu)
Change the keyboard repeat rate and key delay from this menu.

.|
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Power Menu _
Figure5-6

Insyde Software SCU For Intel chipset Aug 29, 2003 6:40:02 am
Startup Memory Disks Components Exit POWGI’ Menu
— Devices \ Enable Power Saving

Hard Drive C = 30007 MB Low Power Saving

_ Medium Power Saving
_ High Power Saving
\ Customize >

CPU SpeedStep Controls

»
N Turn on power for wireless devices

640 KB
252928 KB
64 KB
320 KB
253952 KB
1024 KB

Base
Extended
Shadow
Reserved
Total RAM

Cache (Ext)

Enable the power to wireless devices. If not in use, please turn off the
power to these devices for power saving.

This menu allows you to adjust the power saving options. If you are using a
Windows OS, then the power saving options are best set there (see “Power
Management Features” on page 3 - 17).

I
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S
CPU SpeedStep

Controls & CPU
Performance

The settings for CPU
SpeedStep Controls
will have an affect on
the CPU’s speed and

performance (in order
to save power under

certain
See

conditions).

for more
details on how the set-
tings control the CPU
speed and perfor-
mance.

Low/Medium/High/Customize Power Saving (Power Menu)

You may choose to set power saving options for Low, Medium or High power
savings in this menu, or alternatively you may Customize the settings to
change the time until the hard disk goes in to standby. These settings apply to
Non-Windows operating systems only (Windows OS’s use the CPU Speed-
Step Controls and/or the Windows Power Management/Options as outlined in
“Power Schemes” on page 3 - 19, 3 - 20 and “Advanced Power Saving” in
Appendix A.

CPU SpeedStep Controls (Power Menu)
You can set the mode for the Intel CPU SpeedStep controls here (“Intel CPU
SpeedStep Controls” on page A - 3 gives full detail on the settings).

» Performance Mode Always - Enable this option to give maximum avail-
able performance when the battery is not low.

« Battery Optimized Mode Always - Enable this option to save maximum
power when the computer is powered by battery.

» Automatically Switch (Default Setting) - Enable this option to have the
computer detect if it is powered by battery or AC adapter, and change the
setting accordingly.

Turn on power for wireless devices (Power Menu)
You may choose to enable/disable power for the wireless devices from this
menu option.

5 - 16 Power Menu
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Exit Menu

Figure5-7

Insyde Software SCU For Intel chipset Aug 29, 2003 6:40:02 am .
Startup Memory Disks Components Power EXIt Menu
— D i .
evices Save and Exit »>
) Exit (No Save) >
Hard Drive C = 30007 MB
Default Settings » SCITS
Restore Settings 4
Memory
Base = 640 KB
Extended = 252928 KB
Shadow = 64 KB
Reserved = 320 KB
Total RAM = 253952 KB
Cache (Ext) = 1024 KB

Save current settings and return to previous work

Save and Exit (Exit Menu)
This option allows you to exit the SCU and save the changes you have made.

Exit Menu 5 - 17
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Exit (No Save) - (Exit Menu)
This option allows you to exit the SCU without saving any changes made.

Default Settings (Exit Menu)
This option allows you to reset the SCU settings to the original defaults before
any changes were made to the system.

Restore Settings (Exit Menu)
This option will allow you to restore the SCU settings to the last changes you
had made.

. |
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Chapter 6: Upgrading The Computer

Overview

This chapter contains information on upgrading the computer. Follow the ’ﬂ‘

steps outlined to make the desired upgrades. If you have any trouble or prob- Warranty Warning

lems you can contact your service representative for further help. Before you _

begin vou will need: Please check with your
giny : service representative

- . before undertaking any

» A small crosshead or Phillips sgrewdrlver e T e

» A small regular slotted screwdriver find out if this will VOID

* An antistatic wrist strap your warranty.

Before working with the internal components you will need to wear an anti-
static wrist strap to ground yourself because static electricity may damage the
components.

The chapter includes:

» Replacing the Battery
» Replacing the HDD
» Upgrading the System Memory

Please make sure that you review each procedure before you perform it.

. |
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When Not to Upgrade

;Zl: These procedures involve opening the system’s case, adding and sometimes
replacing parts.

Power Safety
Warning

You should not perform any of these upgrades if:
Before you undertake

SUEREEE e o Your system s still under warranty or a service contract
dures, make sure that

you have turned off the * You don’t have all the necessary equipment
power, and discon- * You’re not in the correct environment

Jesl RS« You doubt your abilities

and cables (including

telephone lines). It is . . i

advisable to also re- Under any of these conditions, contact your service representative to purchase
move your battery in or replace the component(s).

order to prevent acci-

dentally turning the

machine on.

6 - 2 Overview
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Removing the Battery

If you are confident in undertaking upgrade procedures yourself, for safety 7&‘

reasons it is best to remove the battery. Warranty Warning

Battery Removal Process Please check with your
Turn the computer off, and turn it over. service represe_ntative
Locate the battery bay as highlighted in Figure 6 - 1. before undertaking any

upgrade procedures to
find out if this will VOID
your warranty.

Slide the battery lock in the direction of the arrow @.

Slide the battery lock in the direction of the arrow Q and hold it in place.
Slide the battery in the direction of the arrow Q then lift it up and out of the
computer’s battery bay.

agrwnE

Figure6-1
Battery Removal

Removing the Battery 6 - 3
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Upgrading the Hard Disk Drive

7£l< The hard disk drive can be taken out to accommodate other 2.5" IDE hard disk
HDD System drives. Follow your operating system’s installation instructions, and install all
Warning necessary drivers and utilities (as outlined in “What to Install”” on page 4 - 2),

New HDD's are blank. when setting up a new hard disk.

e B e Hard Disk Upgrade Process

sure:
You have backed up any 1. Turn off the computer, and turn it over and remove the battery.
data you want to keep 2. Remove screw 0 from the hard disk cover.

UG lelos 3. Slide the hard disk assembly in the direction of the arrow @.
You have all the CD-
ROMs and FDDs re-
quired to install your oper-
ating system and
programs.

If you have access to the
internet, download the lat-
est application and hard-
ware driver updates for
the operating system you
plan to install. Copy these
to a removable medium.

Figure 6 - 2
HDD Release

6 - 4 Upgrading the Hard Disk Drive
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Upgrading The Computer

Lift the hard disk assembly out of the computer.
Remove screws @ - @ from the hard disk case and remove the hard disk.
Reverse the process to install the new hard disk.
Figure 6 - 3
HDD Removal

Upgrading the Hard Disk Drive 6 - 5
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Upgrading the System Memory (RAM)

The computer has two memory sockets for 200 pin Small Outline Dual In-line
(SO-DIMM) - DDR 266 MHz - type memory modules. The main memory can
be expanded up to 1024MB. The SO-DIMMs supported are 256MB, and
512MB in size, and the total memory size is automatically detected by the
POST routine once you turn on your computer.

Memory Upgrade Process

1. Turn off the computer, and turn it over and remove the battery.
b 2. Remove screws @ - @ from the memory socket cover @), and remove the
cover.
Figure 6 -4
Memory Socket Cover
Removal

6 - 6 Upgrading the System Memory (RAM)



3. Gently pull the two release latches on the sides of the memory socket in the

direction of the arrows (@ & @ in Figure 6 - 5).

sl

1 o

4.  The module @ will pop-up, and you can remove it.

5. Insert a new module holding it at about a 30° angle and fit the connectors
firmly into the memory slot.

6. The module’s pin alignment will allow it to only fit one way. Make sure the
module is seated as far into the slot as it will go. DO NOT FORCE the
module; it should fit without much pressure.

7. Press the module in and down towards the mainboard until the slot levers

click into place to secure the module.

Replace the memory socket cover and the 4 screws (see Figure 6 - 4).

9. Restart the computer to allow the BIOS to register the new memory
configuration as it starts up.

©

Upgrading The Computer

PR
Contact Warning

Be careful not to touch
the metal pins on the
module’s  connecting

edge. Even the clean-
est hands have oils
which can attract parti-
cles, and degrade the
module’s perfor-
mance.

Figure 6 - 5
Removing/
Installing a RAM
Module

Upgrading the System Memory (RAM) 6 - 7
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Upgrading the Processor

7£l< If you want to upgrade your computer by replacing the existing processor with
Warranty a faster/new one you will need to contact your customer service representa-
tive. We recommend that you do not do this yourself, since if it is done incor-

The CPU is not a user .
rectly you may damage the processor or mainboard.

serviceable part.
Opening this compart-
ment, or accessing the

CPU in any way, may
violate your warranty.

Unauthorized tamper-
ing with the HDD may
also violate your war-
ranty.

.|
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Chapter 7: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you
may want to try to solve the problem yourself. This chapter lists some common problems and their possible
solutions. This can’t anticipate every problem, but you should check here before you panic. If you don’t
find the answer in these pages, make sure you have followed the instructions carefully and observed the
safety precautions in the preface. If all else fails, talk to your service representative. You should also make
a record of what happened and what remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should
preview this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try

turning it off for a few minutes and then rebooting. You will lose any unsaved data, but it may start work-

ing again. Then call your service representative.

. |
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Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer
appears not to be working.

Power - Is the computer actually plugged into a working electrical outlet? If plugged into a
power strip, make sure it is actually working. Check the LED Power Indicators (see “LED
Power Indicators” on page 2 - 5) to see the computer’s power status.

Connections - Check all the cables to make sure that there are no loose connections anywhere.

Power Savings - Make sure that the system is not in Hibernate or Standby mode by pressing the
keys configured in your Power Management/Power Options (see “Conserving Power (System)”
on page 3 - 21), or by pressing the Fn + F4 key combination, to wake-up the system.

Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust
the brightness (see “Advanced Video Controls” on page 3 - 2).

Display Choice - Press Fn + F7 to make sure the system is not set to only a monitor display (see
“Function Key Combinations” on page 3 - 13).

Boot Drive - Make sure there are no floppy disks in any floppy drive attached when you start up
your machine (this is a common cause of the message “Invalid system disk - Replace the disk,
and then press any key” / “Remove disks or other media. Press any key to restart”).

7 - 2 Basic Hints and Tips
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Backup and General Maintenance

» Always backup your important data, and keep copies of your OS and programs safe, but close to
hand. Don’t forget to note the serial numbers if you are storing them out of their original cases,
e.g. ina CD wallet.

* Run maintenance programs on your hard disk and OS as often as you can. You may schedule
these programs to run at times when you are not using your computer. You can use those that are
provided free with your OS, or buy the more powerful dedicated programs to do so.

» Write down your passwords and keep them safe (away from your computer). This is especially
important if you choose to use a Boot password for the SCU (see “Boot and SCU Passwords
(Startup Menu)” on page 5 - 10).

» Keep copies of vital settings files such as network, dialup settings, mail settings etc. (even if just
brief notes).

S

Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate
your warranty.

Backup and General Maintenance 7 - 3
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Viruses

 Install an Anti-Virus program and keep the definitions file (the file which tells your program
which viruses to look for) up to date. New computer viruses are discovered daily, and some of
them may seriously harm your computer and cause you to lose data. Anti-Virus programs are

commercially available and the definitions file updates are usually downloadable directly from
the internet.

» Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from
within e-mail attachments so take care when opening any attached file. You can configure most
Anti-Virus programs to check all e-mail attachments. Note: You should also beware of files

from people you know as the virus may have infected an address book and been automatically
forwarded without the person’s knowledge.

» Keep a “Boot Floppy Disk” or “Bootable CD-ROM?” (this disk provides basic information
which allows you to startup your computer) handy. You may refer to your OS’s documentation for
instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or
at least instructions on how to make one).

7 - 4 Viruses
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Upgrading and Adding New Hardware/Software

» Do not be tempted to make changes to your Windows Registry unless you are very sure of what
you are doing, otherwise you will risk severely damaging your system.

» Don’t open your computer or undertake any repair or upgrade work if you are not comfortable
with what you are doing.

* Read the documentation. We can assume, since you are reading this that you are looking at the
computer’s manual, but what about any new peripheral devices you have just purchased? Many
problems are caused by the installation of new hardware and/or software. Always refer to the doc-
umentation of any new hardware and/or software, and pay particular attention to files entitled
“READ ME” or “READ ME FIRST”.

* When installing a new device always make sure the device is powered on, and in many cases you
will need to restart the computer. Always check that all the cables are correctly connected.

» Make sure you have installed the drivers for any new hardware you have installed (latest driver
files are usually available to download from vendor’s websites).

.|
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» Thoroughly check any recent changes you made to your system as these changes may affect one
or more system components, or software programs. If possible, go back and undo the change you
just made and see if the problem still occurs.

» Don’t over complicate things. The less you have to deal with then the easier the source of the
problem may be found; Example - if your computer has many devices plugged into its ports, and
a number of programs running, then it will be difficult to determine the cause of a problem. Try
disconnecting all of the devices and restarting the computer with all the peripheral devices
unplugged. A process of elimination (adding and removing devices and restarting where neces-
sary) will often find the source of a problem, although this may be time consuming.

7 - 6 Upgrading and Adding New Hardware/Software
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Troubleshooting

Problem

Possible Cause - Solution

You turned on the power
but it doesn’t work.

Battery missing / incorrectly installed. Check the battery bay, make sure the battery is
present and seated properly (the design of the battery only allows it to go in one way).
Make sure there’s nothing interfering with the battery contacts.

The battery LED indicator
E, is blinking orange
and/or a beeping sound
is heard.

Low Battery. Plug in the AC power source. If the computer doesn’t start up immediately,
turn it off then on again.

You are losing battery
power too quickly.

The system is using too much power. If your OS has a Power Options scheme (see
“Power Schemes” on page 3 - 19) check its settings. You may also be using a PC Card
device that is drawing a lot of power.

Actual battery operating
time is shorter than
expected.

The battery has not been fully discharged before being recharged. Make sure the battery
is fully discharged and recharge it completely before reusing (see “Battery Information”
on page 3 - 24).

Power Options have been disabled. Go to the Control Panel in Windows and re-enable
the options.

A peripheral device or PC Card is consuming a lot of power. Turn off the unused device to
save power.

. |
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Problem Possible Cause - Solution
The computer feels too Make sure the computer is properly ventilated and the vents/fan intakes are not blocked
hot. (see “Overheating” on page 1 - 16). If this doesn’t cool it down, put the system into

Hibernate mode or turn it off for an hour. Make sure the computer isn’t sitting on a thermal
surface. Make sure you’re using the correct adapter.

Make sure that your notebook is completely powered off before putting it into a travel bag
(or any such container). Putting a notebook which is powered on in a travel bag may cause
the vents/intakes to be blocked.

7 - 8 Power
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Display

Problem Possible Cause - Solution
Nothing appears on The system is in a power saving mode. Toggle the sleep/resume key combination, Fn + F4
screen. (see “The Keyboard” on page 2 - 17).

The computer is set for a different display. Toggle the screen display key combination, Fn
+ F7. If an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears onthe | You haven't installed the video driver and configured it appropriately from the Control
external monitor | have Panel. See “Video (Win2000)" on page 4 - 9 & “Video (WinXP)” on page 4 - 15 for
plugged in and powered instructions on installing the driver (see “Making Adjustments for the Display” on
on. page 3 - 6 for instructions on configuring the video driver).

You haven't used the key combination to switch the display options. Press the Fn + F7 key
combination to toggle through the options.

2N\
2 &
Windows Media Player and Screen Rotation
If you are playing a DVD/VCD video in Windows Media Player, do not rotate the screen while playing the video. If you wish to

rotate the screen, quit the Media Player program first, rotate the screen, then open the player to play the video.

Make sure the screen rotation driver (see ) is installed before attempting to rotate the screen.

Display 7 - 9



Troubleshooting

Boot Password

Problem Possible Cause - Solution
You forget the boot If you forget the password, you may have to discharge the battery of the CMOS. Contact
password. your service representative for help.

SNE
S

Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.

7 - 10 Boot Password



Troubleshooting

Audio

Problem Possible Cause - Solution
The sound cannot be The volume might be set too low. Check the volume control in the Volume Control Panel
heard or the volume is in the Windows taskbar, or use the key combination Fn + F5 and F6 (see “The Function
very low. Keys” on page 2 - 17) to adjust.
The sound cannot be The digital CD audio needs to be enabled. See “Playing Audio CD’s in Windows 2000”
heard when playing an on page 2 - 10 for instructions on enabling CD audio for an external USB device.
audio CD in an external
USB CD device in the
Windows 2000 OS.
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Troubleshooting

CD Device (Optional)

Problem

Possible Cause - Solution

The compact disc cannot
be read.

The compact disc is dirty. Clean it with a CD-ROM cleaner kit.

The compact disc tray
will not open when there
is a disc in the tray.

The compact disc is not correctly placed in the tray. Gently try to remove the disc using the
eject hole (see “Loading CDs or DVDs” on page 2 - 11).

The system cannot read
from the optional CD/
DVD device.

The system cannot not read from the optional USB 2.0 CD/DVD device. When used with
your computer the optional USB 2.0 CD/DVD device must be powered by an AC power
source via the AC adapter. When used with the AC adapter make sure the power switch is
set to EXT (external power).

The regional codes can
no longer be changed.

The regional codes have already changed the maximum 5 times - See “DVD Regional
Codes” on page 2 - 12.
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Troubleshooting

Keyboard and Mouse

Problem Possible Cause - Solution
Unwelcome numbers If the LED ﬁll is lit, then Num Lock is turned ON. Press and release the Fn & Num Lk key
appear when typing. combination (see “Numeric Keypad” on page 2 - 18).

d

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The
system will detect and enable it automatically. However special functions/hot keys unique to the system’s regular
keyboard may not work.

Keyboard and Mouse 7 - 13



Troubleshooting

Operation

Problem

Possible Cause - Solution

The system performance
appears to be getting
slower.

The system’s power saving features have reduced CPU performance in order to save
power. The Power Schemes setting in Windows, or the Intel CPU SpeedStep settings can
be configured to reduce CPU speed and performance in order to save power. See “Power
Schemes” on page 3 - 19 and “Advanced Power Saving” on page A - 1 for more
information on adjusting the settings.

The system freezes or
the screen goes dark.

The system’s power saving features have timed-out. Use the AC adapter, press the sleep
(Fn + F4) key combination, or press the power button (see “Configuring the Power
Button” on page 3 - 23).

The system never goes
into Hibernate mode.

Make sure you have enabled Hibernate in the Power Options control panel in your OS
(see “Hibernate” on page 3 - 22).

The system turns goes in
to a power saving mode
when rotating the swivel
screen.

The swivel screen has accidentally hit the left LCD cover sensor, and triggered a power
saving mode, when rotating the LCD swivel screen. It is recommended that you set the lid
(left LCD cover sensor) power button to “Do nothing”.

The infrared device and
the computer cannot
communicate with each
other.

The infrared port is blocked. Make sure nothing is between your system’s infrared port and
the destination’s port.

The computer’s settings for Fast Infrared (FIR) are not configured. Follow the steps in
“Configuring the Infrared Transceiver” on page 2 - 26.
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Appendix A: Advanced Power Saving

This Appendix contains information on Power Schemes and how they affect
the computer’s CPU performance, and information on Intel CPU Speed Step
controls.




Power Schemes & Processor Performance

Windows defines four control policies (see sidebar) used with each power

4

Windows Control scheme.
Policies

Constant ~ CPU’s Power Scheme AC Power DC Power
performance always

runs at lowest level Home/Office Desk None Adaptive
Adaptive ~ C_:PU'S per- Portable/Laptop Adaptive Adaptive
formance will be ad-

justed as demanded Presentation Adaptive Degrade

37 i SYEIE Always On None None

Degrade ~ CPU'’s per-
formance starts at low- Minimal Power Management Adaptive Adaptive
est level and reduces
as battery discharges

Max Battery Adaptive Degrade

ﬂiﬁ&ﬁ?ﬁf rﬂ?‘rsfog; Set the Power Scheme which is most appropriate for the conditions and the

the highest available applications you are using (e.g. games, 3D applications, audio and video pro-

performance state grams etc. usually require high CPU performance). See also Table A-2 on
page A - 7/Table A-3 on page A - 8 for further information on power saving
Table A - 1 settings and CPU performance.

Power Scheme
Control Policies



Intel CPU SpeedStep Controls

Additional controls are available to support the Intel Pentium M processor’s
mobile power management features. (It is not necessary to download and run
the updated driver if you have an Intel Celeron M processor, however
Table A-3 on page A - 8 lists the CPU SpeedStep settings for Celeron M pro-
cessors.) These controls may be adjusted in the Intel CPU SpeedStep settings
in the BIOS. See “BIOS Utilities” on page 5 - 1 for details on how to access
the BIOS utilities, and “CPU SpeedStep Controls (Power Menu)” on page 5
- 16 for the specific menu.

Windows 2000 and Windows XP with Service Pack 1 installed support the ba-
sic features of the Intel CPU SpeedStep controls. As long as you have Win-
dows XP with Service Pack 1 installed, you may download and install an
additional processor driver to support additional features such as Intel En-
hanced SpeedStep Technology and Intel Deeper Alert Sleep State. The in-
structions on downloading the driver are in the sidebar. You can check if your
current processor driver for Windows XP (with Service Pack 1 installed)
needs to be updated by following the procedure listed on the following pages:

4

Windows XP Service
Pack 1 Driver to
Support Power

Management Features

The driver that sup-
ports the mobile pro-
cessor power
management features
of Intel Pentium M Pro-
cessors will be in-
stalled if you
automatically update
your Windows XP ver-
sion (you must have
Service Pack 1 in-
stalled) from the Mi-
crosoft website.
Further information is
available if you search
the Microsoft website
for article Q332179
(enter the article num-
ber in the search box
and click Go).




Checking the Processor Driver Version

1.

No

If you can see the My Computer icon on your desktop (if you cannot see
the My Computer icon go to step 2) click on it once to select it, then
right-click it to make the sub-menu appear and scroll down to Properties
and click on it (go to step 3).

If you cannot see the My Computer icon click Start (menu), then point
to (but don’t click just highlight it) My Computer. Right-click it to make
the sub-menu appear and scroll down to Properties and click on it (go to
step 3).

Click the Hardware (tab), then click Device Manager (button).

Click “+” next to Processors (if its sub-items are not shown).
Double-click Intel(R) Pentium(R) M processor 1*00MHz and click
Driver (tab).

Click Driver Details (button).

If the driver is the updated version, the suffix gv3.sys will appear in the
Driver files box, and you do not need to update it (see Figure A - 1 on the
following page).



Driver File Details [Z %] Bl river File Details

@ Intel(F) Pentium(R] M processor 1300MHz @ Intel(F) Pentium{R] M processor 1300MHz

gﬂ\Lel files: Liriver files:

Updated driver

Provider: Microzoft Corporation Provider: Microzoft Corporation

If you do not see the suffix gv3.sys you will need to download and install the
driver (see the instructions on page A - 3). When the driver is downloaded fol-
low the two part instructions on the following page to install and run the driver
(you will need to Unzip the contents of the Zip file to a location on your hard

disk).

FigureA-1
Processor Driver
Version
(WinXP SP1)
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CPU Performance with
SpeedStep

The CPU SpeedStep
options will adjust the
speed of the CPU ac-
cording to the setting in
the BIOS, and in some
cases this will reduce
the CPU performance
in order to conserve
power  consumption
(generally  speaking
the higher the speed a
CPU runs, the more
power it will consume).
You will need to set the
CPU SpeedStep set-
tings (and the Win-
dows Power Scheme
settings) in order to
gain a balance be-

tween good perfor-
mance and power
saving.

Installing the Driver

1.

ok ow

~N

8.

9.

If you can see the My Computer icon on your desktop (if you cannot see
the My Computer icon go to step 2) click on it once to select it, then
right-click it to make the sub-menu appear and scroll down to Properties
and click on it (go to step 3).

If you cannot see the My Computer icon click Start (menu), then point
to (but don’t click just highlight it) My Computer. Right-click it to make
the sub-menu appear and scroll down to Properties and click on it (go to
step 3).

Click the Hardware (tab), then click Device Manager (button).

Click “+” next to Processors (if its sub-items are not shown).
Double-click Intel(R) Pentium(R) M processor 1*00MHz and click
Driver (tab).

. Click Update Driver (button).
. When the Hardware Update Wizard appears, click “Install from a list or

specific location (Advanced)” then click Next.

Select “Search for the best driver in these locations.” and select ONLY
“Include this location in the search:”.

Navigate (Browse...) to the GV3 Folder (the location where you have
unzipped the downloaded file) and click OK > Next.

10.Click Finish > Yes to restart your computer.
11.After the restart browse to the GV3 Folder (the location where you have

unzipped the downloaded file) and run the
Q330512_WXP_SP2_X86.EXE file.



CPU Windows 2000 or Windows XP Windows XP Service Pack 1
SpeedStep with Basic Service Pack 1 with updated Driver
Settings for
Pentium M

Power Source CPU Speed Power Source CPU Speed
Processors
ACI CPU Max Speed || AC | 000MHz ~ Max
n ax Spee n Speed*
Performance 600MH
Mode Always z-
y Battery (not low) 1300MHz Battery (not low) 1300MHz
Low Battery 600MHz Low Battery 600MHz
Battery AC In 600MHz AC In 600MHz
Optimized
Mode Always Battery (not low) 600MHz Battery (not low) 600MHz
Low Battery 600MHz Low Battery 600MHz
600MHz ~ Max
AC In CPU Max Speed || AC In *
Automatically Speed
Switch
Battery (not low) 600MHz Battery (not low) 600MHz
Low Battery 600MHz Low Battery 600MHz

*Max Speed as defined by the Power Scheme set in Windows ( page A - 2).

The Above table applies to Pentium M processors only.

A-7
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CPU SpeedStep
Control Settings

You can adjust the
SpeedStep control set-
tings from the BIOS (see
“CPU SpeedStep Con-
trols (Power Menu)” on
page 5 - 16). The default
BIOS setting is Auto-
matically Switch. How-
ever if the CPU settings
are at *Max Speed, the
CPU speed will still be
affected by the Win-
dows Power Scheme
setting (this may also
adjust the CPU speed).

Table A-2
Pentium M CPU
SpeedStep Settings




4

CPU SpeedStep
Control Settings

You can adjust the
SpeedStep control set-
tings from the BIOS (see
“CPU SpeedStep Con-
trols (Power Menu)” on
page 5 - 16). The default
BIOS setting is Auto-
matically Switch. How-
ever if the CPU settings
are at the maximum
speed, the CPU speed
will still be affected by
the Windows Power
Scheme setting (this
may also adjust the CPU
speed).

Table A -3
Celeron M CPU
SpeedStep Settings

CPU Windows 2000 or Windows XP with Basic Service Pack 1
SpeedStep
Settings CeleronM | CeleronM | CeleronM | Celeron M
for Power 1200MHz 1300MHz 1400MHz 1500MHz
Celeron M Source CPU CPU CPU CPU
Processors Speed Speed Speed Speed
AC In 1200MHz 1300MHz 1400MHz 1500MHz
Performance | Battery (not || 500\, | 1300MHZ) 1225MHz 1312MHz
Mode Always | low)
Low Battery 600MHz 650MHz 525MHz 562MHz
AC In 600MHz 650MHz 525MHz 562MHz
Battery
Optimized Battery (not 600MHz 650MHz 525MHz 562MHz
Mode Always | low)
Low Battery 600MHz 650MHz 525MHz 562MHz
AC In 1200MHz 1300MHz 1400MHz 1500MHz
Automat- Battery (not
cally Switch low) y 600MHz 650MHz 525MHz 562MHz
Low Battery 600MHz 650MHz 525MHz 562MHz

The Above table applies to Intel Celeron M processors only.

|
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Appendix B: Model A Specifications

Feature

Specification

Processor Types

Intel Pentium® M Processor (478-pin) Micro-
FCPGA Package

Intel Pentium® M Processor (478-pin) Micro-
FCPGA Package

Intel Celeron® M Processor (478-pin) Micro-
FCPGA Package

(10.13) 0.13 Micron Process Technology, 1MB
On-Die L2 Cache & 400MHz Front Side Bus -
1.3/1.4/1.5/1.6/1.7 GHz

(90nm) 90 Nanometer Process Technology,
2MB On-Die L2 Cache & 400MHz Processor
System Bus - 1.7/ 1.8/ 1.9 GHz

(10.13) 0.13 Micron Process Technology,
512KB On-Die L2 Cache & 400MHz
Processor System Bus - 1.2/ 1.3/ 1.4 GHz

Core Logic Intel® 855 GM(E) + Intel 82801DBM (ICH4-M)

Security Security (Kensington® Type) Lock Slot BIOS Password

Memory Two 200 Pin DDR SODIMM Sockets Supporting 256/512MB DDR RAM Modules
Supporting DDR 266/333 MHz Modules Expandable up to 1024 MB

BIOS ACPI 4MB Flash ROM Insyde BIOS

LCD Flat Panel TFT - 14.1" XGA LCD with Built-in Touch Panel and Stylus Pen

Supporting 1024 * 768 dot resolution

LCD Swivel Hinge (allows conversion between Notebook and Tablet Modes)




Feature Specification
Display Intel Chipset 855GM Integrated Graphics
Shared Video Memory Architecture Supporting up to 32MB (Default Setting 32MB)
Storage Easy Changeable 2.5" 9.5 mm (h) IDE HDD Built-in 4-in-1 Card Reader for the following
Supporting Ultra DMA 66/100 formats:
SD (Secure Digital)
MMC (Multi Media Card)
MS (Memory Stick)
SM (Smart Media Card)
Audio Integrated Direct Sound Audio Compliant with AC'97 2.2
2 Built-In Speakers
Keyboard, Winkey Keyboard 4 Hardware Buttons:
Pointing Device & | Built-In TouchPad “Q" for screen rotation/power
Buttons Tab
Escape
Scroll Up/Scroll Down/Enter
Indicators 7 LED Indicators (Power/Suspend, Battery, HDD, Caps Lock, Scroll Lock, Num Lock, Wireless
LAN)




Feature

Specification

Interface &
Communication

Two USB 2.0/1.1 Ports

One Stereo Headphone-Out Jack

One Monaural Microphone-In Jack

One RJ-11 (V.90 K56flex™) Jack for Fax/
Modem

MDC Modem Module Supporting Wake On

Ring

One RJ-45 Jack for 100M (Max) Fast Ethernet
Intel Pro 2100 (802.11b) Mini PCI Wireless
LAN Module

One External (VGA) Monitor Port

One DC-in Jack

One Infrared FIR, IrDA 1.1 Transceiver

One Type || PCMCIA 3.3V/5V Socket
Supporting CardBus

Power Supports ACPI v1.0b Supports Resume From Modem Ring
Management Supports Hibernate Mode Supports Resume From LAN Ring

Supports Standby Mode Close Cover Switch

Supports Battery Low Sleep
Power Full Range AC adapter One Primary Smart Lithium-lon (1800mAH x 6

AC Input 100~240V, 50~60Hz
DC Output 20V, 3.25A, 65W

cells) Battery Pack with Gas Gauge

Environmental
Spec

Temperature
Operating: 5°C ~35°C
Non-Operating: -20°C ~ 60°C

Relative Humidity
Operating:
Non-Operating:

20% ~ 80%
10% ~ 90%

Physical
Dimensions &
Weight

313 (w) x 265 (d) x 26.5/29.5(h) mm

2.3 Kg Without Battery




Feature

Specification

Optional

PC Camera (factory option)
Smart Lithium-lon Battery Pack)

Standard - 1800mAH x 6 cells (40W)
Optional - 1800mAH x 8 cells (53W)

External FDD with USB Interface
External Slim Optical Drive with One of the Following Options:

CD-ROM
DVD-ROM
CD-RW
Combo
DVD-RW
DVD+RW

Handwriting Application
Car Adapter




Appendix C: Model B Specifications

Feature

Specification

Processor Types

Intel Pentium® M Processor (478-pin) Micro-
FCPGA Package

Intel Pentium® M Processor (478-pin) Micro-
FCPGA Package

Intel Celeron® M Processor (478-pin) Micro-
FCPGA Package

(10.13) 0.13 Micron Process Technology, 1MB
On-Die L2 Cache & 400MHz Front Side Bus -
1.3/1.4/1.5/1.6/1.7 GHz

(90nm) 90 Nanometer Process Technology,
2MB On-Die L2 Cache & 400MHz Processor
System Bus - 1.7/ 1.8/ 1.9 GHz

(10.13) 0.13 Micron Process Technology,
512KB On-Die L2 Cache & 400MHz
Processor System Bus - 1.2/ 1.3/ 1.4 GHz

Core Logic Intel® 855 GM(E) + Intel 82801DBM (ICH4-M)

Security Security (Kensington® Type) Lock Slot BIOS Password

Memory Two 200 Pin DDR SODIMM Sockets Supporting 256/512MB DDR RAM Modules
Supporting DDR 266/333 MHz Modules Expandable up to 1024 MB

BIOS ACPI 4MB Flash ROM Insyde BIOS

LCD Flat Panel TFT - 14.1" XGA LCD with Built-in Touch Panel and Stylus Pen

Supporting 1024 * 768 dot resolution

LCD Swivel Hinge (allows conversion between Notebook and Tablet Modes)




Feature Specification
Display Intel Chipset 855GM Integrated Graphics
Shared Video Memory Architecture Supporting up to 32MB (Default Setting 32MB)
Storage Easy Changeable 2.5" 9.5 mm (h) IDE HDD Built-in 4-in-1 Card Reader for the following
Supporting Ultra DMA 66/100 formats:
SD (Secure Digital)
MMC (Multi Media Card)
MS (Memory Stick)
SM (Smart Media Card)
Audio Integrated Direct Sound Audio Compliant with AC'97 2.2
2 Built-In Speakers
Keyboard, Winkey Keyboard 4 Hardware Buttons:
Pointing Device & | Built-In TouchPad “Q" for screen rotation/power
Buttons Tab
Escape
Scroll Up/Scroll Down/Enter
Indicators 7 LED Indicators (Power/Suspend, Battery, HDD, Caps Lock, Scroll Lock, Num Lock, Wireless
LAN)




Feature

Specification

Interface &
Communication

Two USB 2.0/1.1 Ports

One Stereo Headphone-Out Jack

One Monaural Microphone-In Jack

One RJ-11 (V.90 K56flex™) Jack for Fax/
Modem

MDC Modem Module Supporting Wake On

Ring

One RJ-45 Jack for 100M (Max) Fast Ethernet
Intel Pro 2100 (802.11b) Mini PCI Wireless
LAN Module

One External (VGA) Monitor Port

One DC-in Jack

One Infrared FIR, IrDA 1.1 Transceiver

One Type || PCMCIA 3.3V/5V Socket
Supporting CardBus

Power Supports ACPI v1.0b Supports Resume From Modem Ring
Management Supports Hibernate Mode Supports Resume From LAN Ring

Supports Standby Mode Close Cover Switch

Supports Battery Low Sleep
Power Full Range AC adapter One Primary Smart Lithium-lon (1800mAH x 6

AC Input 100~240V, 50~60Hz
DC Output 20V, 3.25A, 65W

cells) Battery Pack with Gas Gauge

Environmental
Spec

Temperature
Operating: 5°C ~35°C
Non-Operating: -20°C ~ 60°C

Relative Humidity
Operating:
Non-Operating:

20% ~ 80%
10% ~ 90%

Physical
Dimensions &
Weight

313 (w) x 265 (d) x 26.5/29.5(h) mm

2.3 Kg Without Battery




Feature

Specification

Optional

PC Camera (factory option)
Smart Lithium-lon Battery Pack)

Standard - 1800mAH x 6 cells (40W)
Optional - 1800mAH x 8 cells (53W)

External FDD with USB Interface
External Slim Optical Drive with One of the Following Options:

CD-ROM
DVD-ROM
CD-RW
Combo
DVD-RW
DVD+RW

Handwriting Application
Car Adapter
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